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General Introduction 
 

 

 

This documentation is composed of five Parts.  

 

Part I provides a general description of the TIMES paradigm, with emphasis on the model’s 

general structure and its economic significance. Part I also includes a simplified mathematical 

formulation of TIMES, a chapter comparing it to the MARKAL model, pointing to 

similarities and differences, and chapters describing new model options. 

 

Part II constitutes a comprehensive reference manual intended for the technically minded 

modeler or programmer looking for an in-depth understanding of the complete model details, 

in particular the relationship between the input data and the model mathematics, or 

contemplating making changes to the model’s equations. Part II includes a full description of 

the sets, attributes, variables, and equations of the TIMES model. 

 

Part III describes the organization of the TIMES modeling environment and the GAMS 

control statements required to run the TIMES model. GAMS is a modeling language that 

translates a TIMES database into the Linear Programming matrix, and then submits this LP to 

an optimizer and generates the result files. Part III describes how the routines comprising the 

TIMES source code guide the model through compilation, execution, solve, and reporting; the 

files produced by the run process and their use; and the various switches that control the 

execution of the TIMES code according to the model instance, formulation options, and run 

options selected by the user. It also includes a section on identifying and resolving errors that 

may occur during the run process.  

 

Part IV provides a step-by-step introduction to building a TIMES model in the VEDA-Front 

End (VEDA-FE) model management software. It first offers an orientation to the basic 

features of VEDA-FE, including software layout, data files and tables, and model 

management features. It then describes in detail twelve Demo models (available for download 

from the ETSAP website) that progressively introduce VEDA-TIMES principles and 

modeling techniques. 

 

Part V describes the VEDA Back-End (VEDA-BE) software, which is widely used for 

analyzing results from TIMES models. It provides a complete guide to using VEDA-BE, 

including how to get started, import model results, create and view tables, and create and 

modify user sets, and step through results in the model Reference Energy System. It also 

describes advanced features and provides suggestions for best practices. 
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1 Introduction 
Part V of the TIMES documentation provides a user manual for the VErsatile Data Analyst 

Back-End (VEDA1-BE) software, which is widely used for analyzing results from TIMES 

models. VEDA-BE is a flexible, user-friendly tool for the construction of analyst tables and 

graphs from structured datasets of any kind.  

VEDA-BE is particularly suitable for analyzing results from GAMS-based models built on 

the concepts of sets for identifying and grouping model components and parameters for the 

management of numeric values, including those obtained from the model solution (e.g. the 

primal and dual solution values obtained from optimization). Any GAMS-based model can be 

linked to VEDA-BE by means of the GDX2VEDA utility and the associated <application>.VDD 

VEDA data definition file (see Appendix B for more). 

VEDA-BE has additional features to work with the TIMES family of models that rely on a 

Reference Energy System (RES) network structure, where nodes in the network represent 

processes, and the arcs linking these nodes represent commodities produced and/or consumed by 

these processes. By means of the GDX2VEDA utility, VEDA-BE is made aware of a TIMES 

model's network topology, allowing the user to trace flows of commodities through the network 

by means of process inputs and outputs.  

VEDA-BE may be used in conjunction with TIMES models built and managed in either the 

VEDA Front-End or ANSWER-TIMES model management systems. This document describes 

how to use VEDA-BE with both systems. It uses the VEDA-TIMES DemoS model described in 

Part IV as an example throughout; however, the instructions are general, and use of this demo 

model is not required in order to follow along.  

 

Part V is organized as follows: 

Chapter 1 Introduction and installation: introduces VEDA-BE and provides instructions to 

download and install the software. 

Chapter 2 Getting started: provides an overview of the user environment, describes how to 

create a new database and how to import TIMES results, and introduces how to 

view results in ExRES and table views. 

Chapter 3 Sets: describes the role of sets in viewing results in VEDA-BE. Explains how to 

construct and modify sets, how to use them in tables, and how to move them 

between VEDA-BE databases. 

Chapter 4 Tables: describes how to build, customize, and manage tables; how to move 

tables between VEDA-BE databases; and some advanced features for working 

with tables. 

Chapter 5 Units handling: describes the VEDA-BE units handling facility. 

Chapter 6 Working with Excel and producing reports: describes ways to use VEDA-BE to 

produce analysis reports, including using VEDA-BE in conjunction with Excel 

and using the VEDA-BE batch mode. 

Chapter 7 Best practices: provides some best practice suggestions. 

Appendix A VEDA-BE Attribute Reference Guide. 

Appendix B The GDX2VEDA utility and the VEDA data definition file. 

                                                 
1 Veda [Sanskrit,=knowledge, cognate with English wit, from a root meaning know], oldest 

scriptures of Hinduism and the most ancient religious texts in an Indo-European language. [The 

Columbia Encyclopedia, 6th ed. New York: Columbia University Press, 2000. ] 
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1.1 Software installation  
Instructions for installing VEDA-BE are available at http://support.kanors-emr.org/. 

 

http://support.kanors-emr.org/
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2 Getting started with VEDA-BE for TIMES modeling  
This section provides a guide to getting started with VEDA-BE for TIMES modeling, including 

creating a new database, importing results into an existing database, and viewing simple tables 

and graphs. 

 

2.1 Bringing TIMES results into VEDA-BE 
VEDA-BE requires as input four text files containing full information on each model run that the 

user wishes to process and examine. These files are produced from model run GAMS Data 

eXchange (GDX) files by the GAMS GDX2VEDA utility (see Appendix B). The generic names 

and role of these files are as follows:  

 

 <scenarioname>.VD, containing the application VEDA-BE header directives (controlling 

the appearance of the main VEDA-BE table specification form) and actual model data; 

 <scenarioname>.VDE, containing the list of individual set member elements for each 

index managed by VEDA-BE with their descriptions; 

 <scenarioname>.VDS, where the set grouping information is provided for the various 

sub-sets associated with each index managed by VEDA-BE, and  

 <scenarioname.VDT>, containing the topology (RES) information, for 

MARKAL/TIMES models only.  

 

These files are deposited by the GDX2VEDA utility in the user's GAMS Work folder. (The 

default path is \VEDA\VEDA-FE\GAMS_WrkTIMES for VEDA-FE users, and 

\AnswerTIMESv6\GAMS_WrkTI for ANSWER users, but the user may choose to set up 

different Work folders, for example, for different projects.) 

Following a model run, in order to analyze results in VEDA-BE, these files must first be 

brought into VEDA-BE. This may be done (occasionally, for example, when starting a new 

project) by creating a new VEDA-BE database from the run results, or (far more often) by 

importing run results into an existing database. Both operations are described in this section, 

along with other results management facilities, after quick instructions on how to follow along 

with the DemoS example database used in this document. 

 

2.1.1 The DemoS working example 

Throughout Part V, we will work with the TIMES DemoS_012 model as an example. The user 

may choose to follow along by downloading the Demo model package.2 The 

ETSAP_DemoS_VFE folder should be copied into the user’s /VEDA/Veda_Models directory, 

and the DemoS_VBE folder should be copied into the user’s /VEDA/VEDA-BE/Databases 

folder. 

To create an example run, we have run the DemoS_012 case, changing the run name so that 

we can compare the results to the DemoS_012 run already in the DemoS_VBE database, as 

shown in Figure 1. We have also created the Gams_WrkDEMO folder to receive our results 

files. (See Part IV for more on running the Demo models in VEDA-FE.) 

 

                                                 
2 Available on the ETSAP website along with the TIMES documentation at  

http://iea-etsap.org/index.php/documentation.  

http://iea-etsap.org/index.php/documentation
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Figure 1: Creating an example DemoS_012 run 

 

2.1.2 Creating a new VEDA-BE database 

To create a new VEDA-BE database, from the File menu choose New Database and then select 

Local. Depending on your set-up, you may now see a window titled “Flavors”. If so, see 

instructions starting at Figure 5 below. You may also see the following message: 

 

 

Figure 2: Prompt to set file locations 

 

Click “Yes”, and you will be delivered to the Input Files Locations window: 
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Figure 3: The Input Files Locations window 

 

Click Add Path, which will bring up a folder Browse window. Scroll to the Veda_FE folder 

and click the “+” next to it. Then select the GAMSWrk folder you have used in your model run, 

as shown in Figure 4, and click OK3. 

 

 

Figure 4: Selecting your GAMSWrk folder in the folder Browse 

 

                                                 
3 If you use ANSWER to produce TIMES model runs, the Input Files Location path is set by 

navigating in this browse to your GAMS Work folder (default GAMS_WrkTI) within your 

AnswerTIMESv6 folder. Although the DemoS_012 model is a VEDA-TIMES model, you may 

follow along with the examples in this guide using the pre-existing DemoS_VBE database. 
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This should return you to the Input Files Locations window, where clicking Continue will 

bring you to the Flavors window: 

 

 

Figure 5: Selecting the run to create a new database in the Flavors window 

 

In the Flavors window, click the "+" next to TIMES (the "flavor" of VEDA model that we will 

be working with), and your model run should appear. Select your run and Click OK. You will be 

prompted for a database name (e.g., DemoS_VBE here), whereupon VEDA-BE will create the 

new database and import your run. When the import is complete, you should see your scenario 

listed on the Scenarios tab. 

A note on terminology: In VEDA-FE and ANSWER, model runs are called cases, and are 

assembled from one or more scenarios consisting of input data that are layered to form the input 

assumptions for a particular case. However, in VEDA-BE, the model runs upon import are 

referred to as scenarios. Because VEDA-BE is generally used only to review TIMES model 

output data, this change in terminology should not cause any (lasting) confusion. 

 

2.1.3 Importing results into an existing database 

It is generally more convenient to work from an existing database, if one has been previously 

created for your model/project, because it will likely be already populated with Sets and Tables 

that are useful for analyzing your model. (Throughout this document, we will work with the 

DemoS_VBE database that is distributed with the DemoS model.)  

Upon starting, VEDA-BE will open the last used database, if any. To open a desired 

database, choose Open Database from the File menu. You will see a folder Browse of all the 

databases (folders) in the (default) /VEDA/VEDA-BE/Databases folder, from which you can 

select the desired database4. 

 

                                                 
4 You may store your databases in any location. Each "database" will always be a folder 

consisting of several Access databases, as described in Section 2.1.5. 
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Figure 6: Opening a database 

 

To import a run or runs into an existing database, from the Results menu choose 

Import/Archive. This brings up the following window: 

 

 

Figure 7: The Import/Archive window 

 

You may see your model run listed here. If so, click on the checkbox next to its name to 

select it, and click OK.  

Alternatively, the Import file list may be blank, because the path to the GAMSWrk folder has 

not been set yet. In this case, click Manage Input Files Locations. This will take you to the 

Input Files Locations window shown in Figure 3, where you can click Add Path and navigate 
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to and select your GAMSWrk folder as described in Section 2.1.2. This should be a one-time 

operation, unless you change GAMSWrk folders, and the Import file list should be populated 

with new results as you conduct runs from now on. 

Note that the Input Files Locations box can also be used to remove a path from a VBE 

database, if desired (for example, if you decide to create separate GAMSWrk folders for 

different projects later on.) 

Once you have selected your run(s) to import and clicked OK, the Tasks window should 

appear, showing you the progress of the import process. Depending on the size of your model, 

this process may take a few seconds (for the DemoS model) up to several minutes for very large 

models. 

 

 

Figure 8: The Tasks window for importing and deleting scenarios 

 

2.1.4 Managing scenarios in a VEDA-BE database 

From the Import/Archive window, one may perform additional tasks to manage the scenarios 

stored in your VEDA-BE database. Clicking on the Delete tab will bring up a list of all the 

scenarios that are currently in the database. Select the scenarios you want to delete by checking 

the checkboxes next to their names and click CONTINUE. This will bring you back to the 

Import tab, where you can select scenarios for Import, if desired, and then click OK to start the 

Delete (and Import, if any) process. 

To streamline the DemoS_VBE database for our use, we’ll delete all the scenarios from 

DemoS 1-11. With the Import/Archive window open, click on the Delete tab to bring up the list 

of all scenarios in the database. Clicking on the checkbox next to "Scenario" (see the circled area 

in Figure 9) will select all scenarios in the list. You may sort the list by scenario name by 

clicking on Scenario, then scroll to the bottom and unselect the DemoS_012 scenarios by 

clicking on each of their checkboxes to clear the checks. Click CONTINUE and then OK to 

start the delete. 
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Figure 9: Deleting scenarios from the database 

 

From the Import/Archive window, you may also delete old VD* files from your GAMSWrk 

folder, by clicking on the Delete Source Files tab and selecting the scenarios for deletion. Once 

you have imported scenarios into your VEDA-BE database, the VD* files are no longer needed 

and should be periodically deleted to save disk space.  

Note that if, upon opening the Import/Archive window, VEDA-BE finds results files with 

the same name but a later time stamp than a scenario already in the database, indicating that you 

have run a new version of a previously imported scenario, it will automatically select that 

scenario for import. You may deselect it, if desired, by clearing the checkbox next to its name. If 

you request the import to proceed, it will first delete the previous version of the scenario. 

 

2.1.5 The structure of a VEDA-BE database 

A VEDA-BE database is a folder residing by default in the /VEDA/VEDA-BE/Databases folder, 

containing several Microsoft Access databases (.mdb files). These include: 

 

 One Access database named VEDA_R_<scenarioname> corresponding to each 

scenario that is currently in the VEDA-BE database; 

 Access databases named VEDA-R and VEDA-Y. These hold the structure of the 

scenario-specific files, and the scenario and table dimensions, and are meant for the 

internal use of the application. Users should never modify these files; and  

 An access database named VEDA_SnT.  

 

The SnT file is of particular importance, as it can be used to transfer Sets and Tables from 

one VEDA-BE database to another, as described in Sections 3.4 and 4.4. The other Access files 

should not be moved or copied by the user from one location to another.   
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2.1.6 Moving/sharing a VEDA-BE database 

The recommended procedure to move an existing VEDA-BE database from one computer to 

another and/or share it with a colleague is to create a new database from one model run, and then 

import any needed scenarios, sets, and tables as follows: 

Select a model run on the old machine, locate the four VD* files from that run in your 

GAMSWrk folder, and compress and move them to the GAMSWrk folder on the other machine. 

Also locate the VEDA_SnT file in the VEDA-BE database folder and copy it to a known 

location on the other machine, such as the Desktop. Next create a new database on this machine 

from the VD* files, following the procedure described in Section 2.1.2. Finally, import desired 

sets and tables from the SnT file, following the procedures described in Sections 3.4 and 4.4. 

Additional scenarios may be imported into the new database by copying their VD* files to the 

new machine's GAMSWrk folder and using the Import/Archive window.  

Merging scenarios, sets, and/or tables from existing one database into another may be 

accomplished by following the same procedure, minus the creation of a new database.  

Note that it is not recommended to short-cut this procedure by moving the entire database 

folder and/or the SnT file to the new machine. Differences in VEDA-FE settings between the 

two machines may cause the required SnT file format to be slightly different, resulting in 

incompatibilities. 

 

2.2 Orientation to the main VEDA-BE window 
If you have imported and deleted scenarios from the DemoS_VBE database as described in 

Section 2.1, your screen should now look something like that shown in Figure 10.  

The arrows in Figure 10 call out the primary features of the main VEDA-BE window. Below 

the Main menu bar (described in Section 2.2.2), the window is divided in two. The left panel is 

the Table definition panel, which contains at its top a dropdown list of existing tables (if any 

have been previously defined). The drop-down menu also contains the option to define a new 

table, as shown in Figure 10. Underneath the menu is the list of dimensions and elements that 

describe the selected table (if any). The user can choose (and then optionally modify) a pre-

defined table from the list, or create a new one altogether. Note that the list of tables shown is the 

one in the folder that has been selected under \View\Open folder(s) in the main menu (see 

Section 4.4). If no folder has been selected, all tables are shown. The table definition process is 

described in Section 4.1. 

The right panel holds the Dimension Tabs, which display the detailed lists of all elements in 

the database. The available dimensions for TIMES models are described in Section 2.2.1. 

Additional features of note in the main window include: 

 

 The Units drop-down menu allows the user to specify the native model units that are 

associated with the table. If the user has defined custom units and conversion factors 

(discussed in Section 5), the display units of the table may be modified inside the table 

view. 

 The View table(s) button processes the table definition, and produces the tabular cube 

view (see Section 2.3) according to the specified criteria. 

 The Global Filter status bar at the bottom indicates whether global filters have been set, 

and if so, for which dimensions and elements. This feature allows the user to set filters 

that will apply to all tables viewed and then later to easily remove them for all tables, 
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without having to redefine the tables. See Section 2.3.5 for instructions on this extremely 

useful feature. 

 

Figure 10: The main VEDA-BE window 

 

2.2.1 The dimension tabs and items lists 

The Dimension tabs organize all the items that are available to view in the VEDA-BE database. 

Each tab lists the available elements corresponding to that dimension. Note that for the Process 

and the Commodity dimensions, the tab is divided into lists of sets of items that TIMES and/or 

the user have defined (above) and the items themselves (below), as shown in Figure 11. 

Each element in a dimension has a code and a description. The description comes in two 

flavors: the original description provided from the model, and the Veda description. You may 

toggle between the Veda and Original descriptions by right-clicking with the cursor in the 

description column and selecting Display Type from the pop-up menu. Initially, these two 

descriptions are identical, but the user may change the Veda description at will by selecting Edit 

description from this pop-up menu. This feature is particularly useful for scenario descriptions, 

and may also by useful for set descriptions or region names, in order to adapt the heading of 

table columns or rows to the terminology of a particular report. 

For the TIMES models, the 9 dimensions are:  

 

 Attribute: describing the kind of results data to be displayed. There are many VEDA 

attributes handled for the TIMES models, including process capacities and investments, 

commodity flows, costs, and marginals. See Appendix A for a full listing. 
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 Commodity and Commodity Set: a commodity is an energy form, a material, an 

emission, or a demand category. In short, a commodity represents a link in the RES 

network (whereas a process, as described below, represents a node of the RES). A 

commodity set is a group of commodities defined by the model or by the user. 

Commodity sets are convenient ways to avoid having to list many commodities when 

defining a table. They will be discussed in detail in Section 3. 

 Process and Process Set (Figure 11): a process is the generic name for a technology or 

an energy source or energy/emission sink. A process set is a group of processes defined 

by the model itself or by the user. Process sets are a convenient way to avoid having to 

list many processes when defining a table. They will be discussed in detail in Section 3. 

 

 

Figure 11: The Process tab, showing process sets above and processes below 

 

 Period: lists all the periods in the model, by milestone year. 

 Region: the various regions represented in the model.  

 Vintage: the vintage year corresponds to the period in which a process was initially 

installed, as opposed to the period in which activity occurs. This view may be useful for 

technologies whose characteristics change with vintage. This dimension also contains the 

reserved tags 0, -, and ¤ for use in characterizing capacity additions and retirements (see 

Appendix A). 

 Time Slice: sub-divisions of model periods according to seasons and time-of-day.  

 User Constraint: lists all user constraints in the model, along with reserved TIMES tags 

that distinguish objective function components (see Appendix A). 

 Scenario: all model runs currently imported in the database, as described in Section 2.1.  
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2.2.2 VEDA-BE main menus and toolbar 

This section summarizes the features available under each of the main menus, as follows. 

 

 File: contains commands to create a New database and Open an existing one; to Backup 

all files in the current database as a single Zip archive and to Restore a database from 

such an archive; and to Quit VEDA-BE. 

 View: besides the usual view choices such as showing or hiding parts of the screen, this 

menu has two important functions: a) to allow the user to select subsets of tables in 

specific folders, and b) to choose the execution mode (interactive or batch). See Sections 

4.4 and 6.2 for these advanced features.  

 Tables: this menu allows the user to define a new table, to save or delete a table, to 

import tables defined in another database and export tables to share with another 

database, to erase Cube files (the final form in which a table is organized), and to open 

the Table Master. See Section 4 for defining and managing tables. 

 Sets: this menu allows the user to create new sets, to edit, delete, or refresh existing sets, 

to import sets defined by another user, and to export sets to another location. See Section 

3 for all operations on sets. 

 Results: this menu allows importing and deleting results, as well as defining the 

directory where result files are stored, as described in Section 2.1.  

 Tools: this menu offers a diverse array of tools, including user Options for setting default 

table layouts and formats (discussed in Section 4.2) and settings for working with 

Exports and Batch Mode (Section 6); operations on Cube Files (Section 2.3.7); the Units 

facility (Section 5); and the ability to Update Excel files containing calculations and 

graphs based on VEDA-BE tables (Section 6.3).   

 Help: this menu provides links to the KanORS Veda Support website and Veda Support 

Forum. The Forum has an active user community and is a very good source of 

information for beginners as well as advanced users. 

 

2.3 Viewing tables 
We are now ready to work with the tables that have been defined in the DemoS_VBE database. 

We’ll begin by verifying that our test run of the DemoS_012 scenario has succeeded in 

duplicating the same solution, by selecting the _SysCost table from the drop-down menu in the 

Table definition panel, as shown in Figure 12. Note that this table is so useful in initial 

assessment of model runs that its creator has chosen to begin its name with an underscore ( _ ) 

character, so that it will always sort at the beginning of the table list. 

The Table definition panel now shows us how this table is constructed. Its specifications 

consist of only a single entry: the attribute Reg_obj. Clicking on the Attributes tab shows us the 

description of this item: Regional total discounted system cost, as shown in Figure 13. Note that 

this item appears in bold, because it is part of the currently selected table’s definition. 

Below the Table Definition form, we see the table’s description, assigned by its creator: 

Objective Function Value. We also see that the table’s creator has set the Units for this table to 

M Euro. These are the native units in the model for the costs shown in this table. Having set the 

native units in the table definition process allows the user to make use of the Units function to 

later change the display units of the table to any units of their choosing.  
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Figure 12: The _SysCost table definition 

 

 

Figure 13: The Attributes tab 

Clicking on View Table(s) brings us into the table View window, as shown in Figure 14. 

VEDA-BE tables are highly dynamic data cubes that may be readily rearranged. Table 

dimensions are shown in either rows (as for Scenario in this example), columns (Region), or "on 
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the page", meaning sitting at the top, as Attribute is here. Dimensions in rows or columns are 

enumerated there, while dimensions on the page are summed over. In this case, there is only one 

Attribute in the table (Reg_obj), so having it on the page merely gets it out of the way without 

changing the results shown.  

Hovering the cursor over any (black) dimension header will cause a cross-hair to appear, 

allowing you to hold down the cursor (left-mouse) and drag this dimension to any other position 

in the table (where a green line will appear). Dragging Region to the top will remove the 

enumerated Region data from the table and show only the sum across regions, as shown in 

Figure 15. Note that the Region header is now enclosed in asterisks ( * ), to alert us that multiple 

values are being summed over. 

The user must take care that dimensions on the page are only those that it is meaningful to 

sum over. For example, it rarely makes sense to sum over Attribute (with the exception of the 

Cost_ components), so when there is more than one Attribute in a table, it should be shown in a 

row or column. Similarly, summing over Scenario is never meaningful, and so Scenario should 

always be in a row or column (with the exception of tables used in single scenario Excel 

workbooks for update using the features described in Section 6.3, to be used with the Global 

Filter selecting a single scenario.) 

 

 

Figure 14: Viewing the _SysCost table 

 

The order of multiple dimensions in row and column positions determines the order in which 

data is nested. (See Section 2.3.6 for an example.) 
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Figure 15: The _SysCost table with Region summed 

 

With this table, we can verify that our test run of DemoS_012 has produced the same 

objective value, and hence the same solution as the original run. However, let us use this simple 

table to explore a few more features in the View window. 

 

2.3.1 Sub-totals 

Dragging Region back to its original column position allows us to see (as in Figure 14) that the 

creator of this table opted to have the displayed values summed over Region. This option is 

toggled by right-clicking while the cursor lies in the row or column listing for the desired 

dimension (in this case, on one of the region names) and selecting Totals from the menu that 

appears. As with dimensions held on the page (rather than in rows or columns), the user must 

take care that the items summed produce a meaningful total.  

 

2.3.2 Changing item display from name to description 

From the same menu, one may choose the Display Type for the selected dimension. As shown in 

Figure 16, the Display Type menu offers the option to view items in the selected dimension by 

their Code (short name), Description, or both, in either order. Switching Scenarios here to a 

display type that includes the description may help us keep track of which scenario is which, for 

example. Note that when only the Code or Description is selected, the unselected option appears 

as a tooltip when you hover over a scenario entry.  

 

2.3.3 Unit conversion 

If a table's native units and relevant unit conversion factors have been specified, a table's display 

units can be converted in the cube (and saved, if desired). Clicking on the drop-down menu next 

to Active Unit above the top of the table reveals that, in addition to the table's native M Euro 

unit, another relevant unit (and its conversion factor with MEuro) has been defined: B Euro.  
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Figure 16: Choosing the display type 

 

Selecting B Euro from the drop-down menu converts all data in the table. Defining units and 

conversion factors is discussed in Section 5. 

 

2.3.4 View window toolbar 

The view window has a toolbar with several icons. The name of each button is shown when the 

cursor is hovered over the corresponding button. Moving from left to right, here is a brief 

description of the tool bar buttons: 

 

 Decrease or increase the number of digits after decimal; 

 Save table changes. The first button saves the highlighted table only, and the next button 

saves all tables currently on screen (in the case of multiple tables). If changes were made 

while in view mode, the user is asked to provide a new name or to use the old name for 

the table (writing over its previous specifications). If you begin entering a new name, a 

checkbox will appear to allow you to retain the old table (with its original name) or 

substitute the new name for the old. Note that these save options save the definition of the 

table, as modified in view mode, as well as any layout modifications. They do not save 

the data values in the table. These are regenerated from the table definition each time the 

table is opened by choosing View Table(s) in the main window, unless the Save Cube 

Files user option has been selected, as described in Section 2.3.7.  

 Sort the table. Ascending and Descending sort table rows by the data in the first column 

(only), while Default returns to sort by the row name. This feature can be useful when 

trying to identify the largest flows/costs in a table; 

 Hide/Show blank/zero values; 
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 Export table (four options are provided: Excel, Word, Html, Text, of which Excel is the 

recommended option) or copy a portion of the table on to the clipboard. When the table is 

exported to a file, the date and time are appended to the table’s name to constitute the 

name of the saved file. See Section 6 for more on using VEDA-BE in conjunction with 

Excel. 

 Produce a graph of a selected table area: first block the table cells desired, then press the 

graph button (discussed further in Section 2.3.8); 

 Print and Preview the current table; 

 Set layout preferences (appearance, font, colors); 

 Set the way multiple windows are shown (cascade, horizontally, vertically). These 

options are useful when several tables are viewed simultaneously.  

 Close the view window. (You may also close individual tables by clicking on the X in the 

upper righthand corner of that table’s window).  

 

The /\ button located on the far right below the toolbar toggles showing and hiding the table’s 

description in the header.  

 

2.3.5 Global Filtering 

While we could easily verify, in this simple table, that the objective function values for the two 

scenarios we wished to compare were identical, in fact we made this task harder for ourselves by 

including four extraneous scenarios in the table. In general, efficient model results analysis is all 

about controlling and limiting what you see to only the essential items. The global filter feature 

supports this practice. 

Global filters are set in the main VEDA-BE window. Close the current table (by clicking on 

the X in the upper right corner of the window or by clicking the Exit icon). Because we have 

modified the table layout, we are prompted to choose whether to Save our changes, Exit without 

saving, or Cancel and keep the table open. As with the Save toolbar buttons described in Section 

2.3.4, clicking the Save button will give you the further choice of saving with a new name 

(optionally retaining the original table) or writing over the original table.   

Back in the main window, there are two methods to set a global filter. Both start from the 

Scenarios tab: 

 

 Option 1: hold down the Control key, and click on the desired scenarios in the scenarios 

list. Their rows will turn yellow, to indicate that they have been set within the global 

filter. 

 Option 2: right click anywhere within the scenarios list, and choose Global Filter from 

the menu that appears. This brings up the selection window shown in Figure 17. Here you 

may select individual scenarios by clicking on them (turning them bold blue), filter 

scenarios by code or description, and Select or Unselect All from the filtered list.  

 

Setting the global filter for the original and re-run DemoS_012 scenarios results in the 

window appearance in Figure 18. The global filter status at the bottom now shows us that the 

global filter has been applied for the selected scenarios. The checkboxes allow you to remove the 

filters by dimension (if filters have been set for one or more dimensions) while retaining their 

specifications. The filters may be reengaged later by re-checking the box.  
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Figure 17: Selecting scenarios for a global filter 

 

 

Figure 18: Main window with global filter set on scenarios 

 

When we click View Table(s) with the filter engaged, we now see only the two selected 

scenarios. This filter will remain active for any subsequent tables created, until it is removed. 

Tables already open will not be affected. 
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Because scenarios and scenario names change often, and the global filter facilitates viewing 

only the scenarios you choose, it is recommended to never include scenarios in a table definition, 

and to simply use the global filter to select scenarios for viewing as you work. Global filters may 

also be set for other dimensions: Region may be convenient for analyzing results in large multi-

region models, and Attribute can be useful in conjunction with the ExRES feature described in 

Section 2.4, to limit results shown in the full attributes mode. 

To save a global filter for later re-use, click on the Gear icon in the lower right corner of the 

main window. Choose New, enter a name for the filter, and click the “check” icon. The filter 

may now be selected at any time by clicking on its name from the drop-down menu under the 

Gear icon. 

 

2.3.6 Additional functions in the table view 

To fully appreciate the power of the VEDA-BE table viewer, we need to work with a more 

complex table. Set a global filter for scenarios DemoS_012, DemoS_012b (carbon tax), and 

DemoS_012c (solar subsidy), and select the ELC Plants Production table. This table consists of 

the attribute Var_Act, or process activity, and several process sets, each named ELExxx. Click 

View Table(s) to open the table view. When we first open the table, it looks like Figure 19.  

 

 

Figure 19: The ELC Plants Production table, as first opened 
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We have Scenario, Region, and ProcessSet on rows, and Period on columns. The ProcessSet 

display has been set to Description Only, and the units have been set to Billion Kwh, from their 

original PJ. 

Let us first drag Region up above to simplify the table. Then drag Scenario to the right of 

ProcessSet. This makes the table appear as in Figure 20 and allows us to compare power plant 

activity by type across scenarios more easily. We see, for example, that coal and gas plants 

entirely shut down by 2025 in the DemoS_012b (carbon tax) scenario, replaced by wind and 

solar plants, and that in the DemoS_012c (solar subsidy) scenario, solar plants take market share 

primarily away from wind plants, leaving the others largely unchanged. 

 

 

Figure 20: The ELC Plants Production table, as rearranged 

 

To get additional detail, pull Process down to the row headers, between ProcessSet and 

Region, so that we may still compare scenarios directly against each other. We see that most of 

the process sets in the table contain more than one process that operates in these scenarios, 

generally an existing process that retires partway through the model horizon, and a new process 

whose activity grows over time. (We will see in Section 3 how these process sets are created.) 

We can focus the view further by removing some items temporarily from view. Each (black) 

dimension header contains a triangle revealing a drop-down menu of all items under that 

dimension in the table definition when clicked. Individual items can be deselected and reselected 

by clearing and re-checking the checkbox next to their names, and the entire list can be selected 

or cleared by holding down the Control key while clicking a single checkbox. 

For example, by selecting only Solar/PV and Wind power plants from the ProcessSet list, and 

only DemoS_012 and DemoS_012c from the Scenarios list, and then pulling both ProcessSet and 

Process up above, we now see the total generation from wind and solar plants in these two 

scenarios, and can see just how close the totals are (Figure 21).  
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Figure 21: The ELC Plants Production table, rearranged to show total solar and wind plant 

activity 

 

Note that if you choose to Save the table after these modifications, both the process set 

selections and the scenario selections will be saved in the table definition, because explicit 

choices have been made for both. 

An alternative to removing items from a table while managing the volume of information 

displayed is to selectively collapse and open sections of the table using the “+” and “-” icons 

next to elements that have dimensions nested beneath them. For example, returning to the 

original ELC Plants Production view shown in Figure 19 and clicking “-” icon next to 

DemoS_012 in the Scenarios column collapses all the results for that scenario, showing just the 

total over all collapsed rows. You may collapse all the table sections associated with a particular 

dimension by right clicking on any item in that dimension and choosing Details from the drop-

down menu that appears. You may then selectively reopen desired sections by clicking on the 

relevant “+” icon. 

 

2.3.7 Saving data cubes 

The table Save operation described in the previous section saves the definitions and layout 

options for tables, which will be recreated from these saved specifications the text time the table 

is viewed. Another kind of "save" operation is possible: saving the data cube itself as it has been 

created. The option to do so is a global user preference, set by choosing Options from the Tools 

menu in the main window, and then checking the box labeled Save Cube Files. If selected, this 

option will reopen an existing table almost instantly, as long as the content of the table has not 

changed since the last request. VEDA-BE keeps track of any potential changes and recreates the 

cube when necessary. This option can greatly speed up work if you expect to view the same 

tables repeatedly. 

When viewing saved cube files, the pivot, select and deselect, and subtotal options are all 

available, but swapping code and description is not. All cubes are deleted whenever scenarios are 

imported or deleted. Choosing Delete Cube File(s) from the Tools menu will manually force a 

delete of all saved cubes. 
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2.3.8 The VEDA-BE graphing function 

A final feature available in the view window is the graphing function. An entire data table or any 

portion thereof may be graphed by selecting the desired data points and either right clicking and 

choosing Graph from the drop-down menu or clicking the graph button on the toolbar. (If no 

data is selected, the entire table will be graphed.) For example, returning the ELC Plants 

Production table to its original Figure 19 configuration, selecting all the data rows for REG1 in 

scenario DemoS_012, and clicking the Graph button yields the graph shown in Figure 22.  

The toolbar at the top of the Graph window contains options to change the type of graph, 

switch rows and columns, copy to the clipboard or export to Excel, and toggle the legend, as well 

as a Graph Settings window with numerous options to format the graph, as well as to hide or 

remove individual series. These simple graphs can help the user quickly get a visual feel for one 

or more data series, but for creating and maintaining more complex or customized graphs for 

presentations and reports, the Update Excel File feature discussed in Section 6.3 is 

recommended. 

 

 

Figure 22: Creating a simple graph in VEDA-BE 

 

2.4 Viewing results in the ExRES 
It is not necessary to define a table every time you wish to view results. Another equally 

powerful, but quite different method for viewing results is the ExRES (for “Extended RES”). 

This tool lets you zero in on model results as they are connected in the model’s Reference 

Energy System (RES). Starting from the main window, the ExRES can be invoked for any 

process or process set, commodity or commodity set, or user constraint to rapidly get results 

information for that item or set. 
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For example, to view results data for commodity BIO (Biomass), right click on its listing on 

the Commodity tab and choose ExRES from the menu that appears. This will create the table 

shown in Figure 23 for all scenarios in the currently set global filter. It shows all data associated 

with the VAR_Fin (Commodity Consumption by Process, or uses) and VAR_Fout (Commodity 

Production by Process, or sources) attributes for the selected commodity. (Had we launched the 

ExRES from a process, VAR_Fin and VAR_Fout would still be the displayed attributes, now 

representing all inputs to and outputs from the selected process.) 

 

 

Figure 23: The ExRES for commodity BIO 

   

This input-and-output-flows view of the ExRES may be toggled with a full results details 

view by clicking the third icon from left in the view window menu bar. 

  

Doing so will display all the results data associated with the selected item. Clicking the icon 

(which changes appearance in this mode to indicate that additional data is being shown) again 

will return to the flows-only view. The full results ExRES view may be refined by setting a 

global filter on desired attributes. For example, setting a global filter on EQ_CombalM, 

VAR_Fin, and VAR_FOut can aid in fuel chain debugging by allowing you to see only 

commodity production, consumption, and prices. 

The ExRES view allows you to move up and downstream in the model RES to trace the 

sources and/or uses of commodities, making it a key tool for model debugging. Clicking on any 

process or commodity name in the table view will launch an ExRES window for that item. This 

may be pursued as far up or down the RES network as needed.  
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For example, clicking on FTE-RSDBIO in the table shown in Figure 23 reveals that this 

process merely changes the name of BIO to RSDBIO for purposes of sector fuel accounting 

(Figure 24). Clicking on RSDBIO then allows us to see that the primary use of increased 

residential biomass in the carbon tax scenario is a new space heating technology (where the 

tooltip of the process description has been shown in Figure 25 by hovering over the process 

name RSHNBIO1).  

 

 

Figure 24: The ExRES for FTE-RSDBIO 

 

To make it readily apparent when you are using an ExRES rather than table view, it is 

recommended to use the view window formatting tool, available from the paint bucket icon 

 in the view window toolbar to make the formatting of ExRES views distinct from table 

views. Figure 25 shows an example, where the table body (Back Color menu option) and items 

lists (Headings Back Color menu option) background color defaults have been changed. Once 

set in a single ExRES view, these formats will be active for all future ExRES views launched in 

the database. 

The ExRES can also be invoked within the table view mode, by right clicking on any 

process, commodity, process set, or commodity set name in the table and choosing ExRES from 

the menu that appears (see Figure 26). This is an excellent way to further investigate the results 

you see in any table.  

From the main window there is an additional ExRES function available by right clicking on 

any commodity, process, or user constraint name: the Related ExRES. This menu item allows 

you to generate an ExRES as follows: 

 

 If selected for a commodity, all Processes consuming or producing that commodity, or all 

User constraints involving that commodity; 

 If selected for a process, all Commodities being consumed or produced by that process, or 

all User constraints involving that process; and 

 If selected for a user constraint, all Commodities or Processes involved in that user 

constraint. 
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Figure 25: The ExRES for RSDBIO, with background coloring options set 

 

 

Figure 26: Invoking the ExRES within a table view 

 

For example, right clicking on UC_RNW-PP_LOW on the UserConstraint tab and choosing 

Related ExRES of  Process generates the ExRES shown in Figure 27, displaying all inputs 

and outputs of the processes involved in that user constraint. 
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Figure 27: The Related ExRES for UC_RNW-PP_LOW 
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3 Sets: A powerful tool 
A key building block in the construction of VEDA-BE tables is the ability to create user-defined 

sets of model processes and commodities. While simple tables, such as the _SysCost table 

viewed in Section 2.3, do not require them, most VEDA-BE tables make use of process and/or 

commodity sets. A set is a group of like items grouped by rule in order to view their results 

together (and in VEDA-FE, to apply common input data.) Upon creation, a VEDA-BE database 

contains only those sets passed from the model by the GDX2VEDA utility, such as process sets 

ELE (electric power plants), DMD (demand devices), and PRE (energy processes), and 

commodity sets DEM (demands), ENV (emissions), and NRG (energy carriers). 

Because a TIMES model may contain hundreds, or even thousands, of processes, the ability 

to group items into sets using logical rules becomes an essential component in the analysis of 

large models. 

Remark: Note that the importance of sets has implications for model design. Structured 

naming conventions for items must be developed and scrupulously adhered to in order to make 

use of the ability to create sets using rules based on item names. Item descriptions may also be 

used in set creation, and so should not be overlooked for holding, in carefully structured form, 

information needed – or information that may be useful in the future – to create sets5.  

 

3.1 The set definition window 
Set definitions can be viewed, edited, and created in the set definition window, which can be 

accessed for an existing set by selecting Edit Set from the Sets menu or right clicking on a set 

name on the Process tab and selecting Edit/View Set from the menu that appears, or, for a new 

set, by choosing New Set(s) from the Sets menu. A combo box in the upper lefthand corner of 

the allow the user to switch between working with commodity and process sets. 

The set definition window allows sets to be defined through rules that include and/or exclude 

items based on: 

 

 membership in other sets, 

 characters in the item name and/or description, and 

 for process sets, input and output commodities. 

 

In specifying rules for item names and descriptions, the wildcards “?”, “_”, and “*” may be 

used to specify a single character wildcard (question mark and underscore6) and a general 

wildcard (asterisk) for any number of characters, respectively. 

The rules that define any existing set, and its resulting members, can most easily be examined 

by right clicking on its listing on the Commodity or Process tab and choosing Edit/View Set 

from the menu that appears. Note that to manipulate the set definition form in any way, including 

                                                 
5 See Wright and Kanudia (2015), “Highly Detailed TIMES Modeling to Analyze Interactions 

between Air Quality and Climate Regulations in the United States,” in Giannakidis, G., Labriet, 

M., Ó Gallachóir, B., Tosato, G. (Eds.), Informing Energy and Climate Policies using Energy 

Systems Models: Insights from Scenario Analysis Increasing the Evidence Base, Springer, for 

one example of how item descriptions have been packed with information in the FACETS 

model. Available at: http://facets-model.com/mats/. 
6 Note that to filter for a underscore in an item name or description, it is necessary to enclose it in 

square brackets (“[ ]”) so that it will be interpreted as a literal character, rather than a wildcard. 

http://facets-model.com/mats/
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to scroll through the Exist in Sets lists, you must press the Edit Set button in the lower righthand 

corner of the window. Within the window, you may move to view another set by selecting its 

name from the Set name drop-down menu in the upper lefthand corner of the window. 

Figures 28-30 show several examples of how these rules may be combined to create sets. 

Figure 28 shows how this window is used to specify a very simple set definition: all commodities 

that contain the string "GAS" in their names. 

 

 

Figure 28: The NRG_GAS set definition 

Figure 29 shows an example of a definition making use of the Exist in and Input Commodity 

criteria: all items in the set ELE that take input commodities having any of four specified strings 

in their names.  

Figure 30 shows a combination of inclusion and exclusion rules to create a very useful type 

of set: all items that exist in the set NRG but not in any of six user-defined commodity sets. This 

set is looking for energy carriers that have been missed in defining the NRG_* user-defined sets, 

and should be empty when all these sets have been properly defined. 

 

3.2 Creating and editing sets 
Sets may be created either by modifying an existing set from the Edit/View Set function 

described in Section 3.1 or by selecting New Set(s) from the Sets menu. Both methods use the 

set definition window described in the previous section to enter the rules to define the set.  

Rules for Inclusion and Exclusion of items can be defined separately in the left and right 

halves of the left panel. The top portion of each half provides checkboxes for inclusion/exclusion 

based upon set membership (Exist/Do Not Exist in Sets boxes). Above these boxes, the 

binoculars icon  opens a search window that may be used to search for sets by name and/or 

description. The “X” icon to the left of the binoculars clears all selections made. Multiple set 

choices made here are combined with an OR logic. That is, if multiple sets are selected for 
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Inclusion or Exclusion, an item must be a member of only one such set to be included or 

excluded. 

 

 

Figure 29: The PP_FOSSIL set definition 

 

 

 

Figure 30: The NRG_MISS set definition 
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Below the set checkboxes are rows in which inclusion/exclusion criteria may be entered 

based upon item name, description, and, for process sets, input and output commodity. Multiple 

criteria may be specified on the name/description/input/output lines, separated by commas (and 

without spaces. These commas within a single line are always interpreted as logical OR. That is, 

to belong in the set specified in Figure 29, the process input commodity must fit only one of the 

four criteria entered into the Input commodity is like line on the Include side of the form. 

Two sets of AND/OR radio buttons are found on each of the Include/Exclude sides. The 

upper one allows the user to control how the set membership and remaining conditions are 

combined. AND here means that both the set membership and the other conditions must hold, 

while OR means that only one is required. For example, again in Figure 29, the choice of AND 

in upper left AND/OR selection means that an item must be in the set ELE and meet one of the 

four stated input commodity conditions in order to belong. 

The bottom set of AND/OR radio buttons on each side controls how conditions on the 

remaining four (two for commodity sets) rows are combined. AND means that conditions stated 

on different rows must all hold, while OR means that only one such condition must hold. 

All of the inclusion and exclusion conditions are logically combined separately, and the final 

set consists of all those items that meet the inclusion conditions and do not meet the exclusion 

conditions. For example, the set shown in Figure 30 includes all items that exist in the set NRG 

and do not exist in all six specified commodity sets. 

Note that sets that are based upon including/excluding members of user-defined sets may not 

be themselves used as Exist/Do Not Exist in Sets criteria, because such nesting of set 

memberships would cause ambiguity in set update processing. 

There are often many possible ways to define a particular set of items. When choosing rules 

for set definition, consider which definition will be easier to maintain as your model evolves over 

time. In general, when choosing between rules based upon name/description or commodity 

input/output, it is recommended to choose the topology-based option wherever it is equally 

parsimonious, because it is more likely to be robust to future model development.  

Once rules have been specified, press the Shortlist button to view the qualifying items. The 

right panel will list qualifying items in the region selected from the Parent Dimensions Region 

menu above the Include/Exclude panels on the lefthand side (by default, the alphabetically first 

region). If items may vary by region, you may wish to check the lists of qualifying items in other 

regions by selecting them from the menu and pressing Shortlist again. If your criteria do not 

yield any items, the following message will appear. Once it fades, you may create an empty set 

or modify your criteria. 

 

 

Figure 31: No elements shortlisted message 

 



 37 

 

Although it is possible at this point to remove some of the shortlisted items from the set 

definition by manually clearing the checkboxes next to their names, this is not recommended. If 

needed, you may enter exclude conditions for particular items based upon their 

names/descriptions.  

Once the set criteria have been satisfactorily defined, press the Create Set button (or, if you 

have been modifying a previous set’s definition, the Update Set button), and a window opens to 

let you name the set (up to 10 characters) and provide a description. If you leave the description 

blank, it will be automatically set identical to the name. A comment for the set (such as its 

intended use) may also be entered at this time, and will appear in the set definition window under 

the description.  

When editing a previously existing set, entering a new name will create a new set with that 

name, leaving the old one unchanged, whereas clicking OK without changing the set name will 

result in overwriting the old definition with the new. 

You may define and/or edit multiple sets in the window before choosing Close when you are 

ready to return to the main window. 

Set memberships are refreshed from their definitions whenever new results or sets are 

imported and when tables using them are viewed.  

 

3.3 Managing sets 
Individual sets may be deleted by right clicking on the set’s name listing on the Commodity or 

Process tab and selecting Delete Set from the menu that appears. You will be prompted by a 

window similar to that shown in Figure 32, letting you know which tables the set is used in and 

asking you to confirm or cancel the delete.  

 

 

Figure 32: Confirm set deletion window 

 

Multiple sets can be deleted by choosing Delete Set(s) from the Sets menu. This brings up a 

window in which sets may be searched for by name/description, and their membership and table 

usage viewed before choosing to delete them. 

The following actions can be performed on sets by choosing the relevant item from the menu 

that appears upon right clicking on a set listing on the Commodity or Process tab: 
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 Copy set: prompts you to enter a name for the new set. You may then modify the new set 

as needed;  

 Rename set; 

 Edit description; 

 Copy set elements to clipboard: puts the names of all set members in the clipboard for 

pasting wherever needed; 

 Used in tables: brings up a window showing which tables the set is used in; 

 Comment for set: allows you to enter a comment which will be visible when the set is 

viewed/edited in the set definition window. 

 

3.4 Sharing sets 
To share set definitions to another database/user/computer, there are two options. All sets in the 

database may be shared by saving the SnT file found in the database folder of the source 

computer to a known location on the second computer. Open the desired destination database 

and choose Import Set(s) from the Sets menu, and then select Access from the dropdown menu 

that appears. This will bring up a Browse window. Locate and select the folder containing the 

SnT file. (Note that the SnT file itself will not become visible in this browse, only the enclosing 

folder.) Next choose Commodity or Process sets from the Select Dimension window that 

appears. This will bring up the Select window shown in Figure 33.   

 

 

Figure 33: Select sets window for importing sets 
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You may enter desired criteria, if any, based on code and/or description. Select/deselect 

individual sets by clicking on their names (which will turn them bold blue), and/or Select 

All/Unselect All with the buttons in the bottom righthand corner. All selected (bold blue) sets 

will be imported into the destination database when you click OK.  

If a set or sets are selected for import with names matching ones already in the database, the 

following window will appear. You can choose to import and overwrite, or skip these sets. 

 

 

Figure 34: Import set overwrite prompt 

 

The SnT file may also be used to share sets created in VEDA-BE with VEDA-FE for use in 

specifying inputs – for example, to identify qualifying renewable electricity generation processes 

for a portfolio standard – by pointing VEDA-FE to the VEDA-BE database folder, using the File 

Locations tab of the VEDA-FE User Options window. 

To share only some of the sets from the source database, choose Export Set(s) from the Sets 

menu, and Excel or Text from the dropdown menu that appears. Next select Commodity or 

Process sets, and provide a name and location for the export file in the window that appears. 

This will bring up a search window similar that shown in Figure 33, where you may search for 

and select sets for export. Sets may then be imported into the destination database by choosing 

Import Set(s) and selecting Excel or Text, as relevant, from the dropdown menu, and then 

following the search and select procedure described above. 
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4 Working with tables 
This section describes how to define and modify tables, how to set default table layout and 

formatting options, how to use the aggregation rules function to create some advanced table 

types, and some tools for managing and sharing tables. 

 

4.1 Defining a new table 
As introduced in Section 2.3, tables are defined in VEDA-BE by specifying which elements from 

each available dimension are to be included. You may think of table creation as a filtering 

process. The VEDA-BE database contains all the results information from the currently imported 

scenarios. Each table selects from and limits that information into a particular view, which can 

then be further shaped in the View Window. 

Table definition takes place in the VEDA-BE main window. You may start the process by: 

 

 Choosing <New Table> from the top of the Table Selection drop-down menu in the 

upper lefthand corner of the Table Definition form (see Figure 10); 

 Choosing New Table from the Table menu; or 

 Pressing Crtl+N. 

 

All three options will give you a blank table definition form, which you may begin filling 

with specifications. Elements may be added to the definition form manually or via the search 

engine, as described below. On some occasions, you may find it more convenient to begin 

creating a new table by selecting and modifying an existing, similar table. When you request the 

table view, you will be given the opportunity to save the modified table with a new name, 

optionally retaining the old table, or to overwrite the previous table definition. 

Manual filtering: Select the desired dimension tab in the right panel and locate the desired 

element in the appropriate list. (Having clicked on any element on a dimension tab, you may 

quickly jump to another element by typing the first letters of its name.) Double-click on the 

selected element (or press the space bar, or press the Insert key) to add it to the left-side table 

definition form. The chosen element is now displayed under the dimension heading in the 

window on the left, while in the right panel its entry turns bold to indicate that it is part of the 

current table definition. This operation can be reversed by highlighting the selected element in 

the left panel and double clicking on it (or pressing the space bar, or pressing the Delete key).  

Filtering via the Search Engine: in the case of dimensions containing many elements, 

manual filtering may quickly become very awkward and time-consuming, due to the sheer 

number of elements. The search tool, launched by clicking the binoculars icon next to each 

dimension listing, allows filtering via a combination of inclusions and exclusions based on the 

names (short or long) of the elements in the dimension being considered. The list of elements in 

the bottom part of the window will be filtered as you type, showing the results of the search. 

Individual items may now be selected from this list by clicking on their names, turning them 

bold blue to show that they are selected, or the entire list may be selected/deselected using the 

Select All/Unselect All buttons. The OK button transfers the selected items to the table 

definition form. (Note that in doing so, they overwrite any items of the same dimension that are 

already on the table definition form.) 

For example, Figure 35 shows one way in which the search engine can be used to select all 

the sector fuel process sets in the DemoS_VBE database. These may then be added to the table 
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definition form (replacing any process sets already loaded onto it) by clicking Select All and 

then OK. 

 

 

Figure 35: Using the search feature to add elements to the table definition 

 

Dimensions for which no elements are specified for a given table are processed as follows: 

 

 Dimensions that are not relevant to a given table are left off the table. (For example, the 

_SysCost table shown in Figure 14 lacks the process and commodity dimensions because 

these are not relevant dimensions of the Reg_obj attribute.) 

 For relevant dimensions for which no specifications have been provided, all available 

elements are presented in the table, subject to any global filter currently in place (see 

Section 2.3.5). 

 The exception to the previous rule is that processes and commodity sets are not added to a 

table when not specified. This is because any given process or commodity can belong to 

any number of process/commodity sets, and so no unambiguous procedure can be used to 

select sets to be added to such a table. 

 

If you wish to make use of the units conversion feature for this table, select the appropriate 

native model units from the drop-down menu in the lower lefthand corner of the table definition 

form. (These units must have been previously defined, as described in Section 5.) 
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The Include Null checkbox in the lower lefthand corner of the screen allows combining 

attributes that have different relevant dimensions. For example, Figure 36 shows a table 

definition form that puts electricity generation and capacity, by fuel type, into the same table. 

Because VAR_FOut takes the commodity index (in this case, we want output of ELC only) and 

VAP_Cap does not, if Include Null was not checked, VAR_Cap would be absent from the 

created table. Include Null allows VAR_Cap to be included although its commodity is null.  

 

 

Figure 36: Using the Include Null checkbox 

 

When you have completed specifying your table definition, click the View Table(s) button. 

You will be prompted to save the table by providing a name and description. (If you leave the 

description field blank, it will be set equal to the name.)  

Note that if you have modified the definition of an existing table, rather than starting from a 

blank table, you will be presented with the table’s original name here. If you click Save without 

providing a new name, the table's previous definition will be overwritten with the new one (and 

you will see a message telling you that the old definition has been removed). If you provide a 

new name, you will be presented with an option to Retain Old Table. 

Clicking Save prompts VEDA-BE to construct the table by applying the filtering criteria 

specified for the table, according to the default layout specified using the user options described 

in the following section. You may then further modify the layout by pivoting, rearranging, and 

deselecting or collapsing items, adding or removing subtotals, and changing display types, as 

described in Section 2.3. 

During the table construction process, a number of quality control feature checks take place. 

If a specified element is now missing from the database, you will seeing a message asking if you 

wish to continue. To remedy this situation for subsequent requests, simply remove the missing 

element from the table definition.  

If the table includes process and/or commodity sets, and any element appears in more than 

one of these sets, an error message similar to that shown in Figure 37 will appear. The Show 



 43 

 

Duplicates option will open a text file listing all elements that appear in multiple sets and halt 

the table creation process. Continue continues with creating the table, and Cancel halts the 

operation. The Don’t Show Duplicates For This Table checkbox prevents this error message 

from being shown in the future. When this message first appears for a given table, it is 

recommended that you choose the Show Duplicates option and inspect the text file to confirm 

that there are no errors in the requested set specifications before proceeding. 

 

 

Figure 37: Duplicate elements error message 

 

Figure 38 shows an example of the Dupes file listing duplicate elements found. 

 

 

Figure 38: Example of Dupes text file listing duplicate elements 
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4.2 Setting table defaults 
The Options function available from the Tools menu offers a number of table layout and 

formatting defaults that may be set, as follows: 

 

 On the General tab, the default number of decimal places shown may be set; 

 The Dimensions tab allows the default display type, location (row, column, or page), and 

use of subtotals to be set for each dimension; 

 The Auto Format tab allows the default format of each portion of the table to be 

adjusted; and 

 The My Sort tab allows the sort order for each dimension to be altered from its 

alphanumeric default. 

 

Changes to the default table settings will be active for new tables, but will not affect existing 

tables.  

 

4.3 Aggregation rules 
The aggregation window, available by clicking the Aggregation button at the bottom of the table 

definition form, allows some simple operations to be requested on tables. Two of the most useful 

are the enumerate and collapse functions. 

Enumerate directs that separate tables be produced for each element in the requested 

dimension. In the example shown in shown in Figure 39, separate tables will be created for each 

available scenario (limited by any scenarios specified in the table definition or by an applied 

global filter.) Up to three dimensions may be enumerated, with the order of table creation set by 

the suffix x on ENUMx when more than one dimension is enumerated.  

If Export to Excel is requested when enumerated tables are open, each table will be placed on 

a different sheet within the same workbook. This can be very useful, for example, to create the 

same report table for each region in a large multi-region model. 

Collapse directs that the selected dimension be summed over all available elements when the 

table is created. The effect is similar to that when the dimension is placed on the page of a table, 

rather than in a row or a column, except that when Collapse is used, the collapsed element is no 

longer available to be dragged back into a row or column and the details revealed. Collapse can 

thus greatly reduce table size, and in large models can make some tables much faster to create. 

(For example, power plant activity and output are tracked by timeslice, so tables containing these 

results may grow quite large. Collapsing by timeslice may make them far more manageable, if 

the timeslice detail is not required.) 

The other options available within the aggregation window should be considered 

experimental. In general, they have been superseded by the ability to update Excel workbooks, 

which may contain any desired calculations and operations, with new results data (see Section 

6.3). 
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Figure 39: The aggregation window 

 

A third type of aggregation – the difference in result values between scenarios – is easier to 

create from within a table view. Within the desired table, right click on the scenario column and 

select Expression, then Diff, and then the scenario from which you want differences calculated 

(see Figure 40). You will be asked if you want to hide the original table. Yes puts only the 

scenario differences in the new table, while No keeps the absolute scenario data in the table 

along with the new scenario differences. You will then be prompted to save the original table, or 

exit without saving any layout or definition changes you have made since opening it. Figure 41 

shows the resulting table, when the original table was hidden.  

You may save the scenario difference table for later use in the same way as for any other 

table: click the SaveTable icon at the top of the table window, or choose Save when closing the 

table. (Note that if you do not provide a new name and select Retain Oil Table, your original 

table will be overwritten.) The Diff expression can be used for other dimensions than scenario, 

but care must be taken to choose a difference that is meaningful. 

When an aggregation rule has been set for a table, the Aggregation button on its table 

definition form will turn bold and receive asterisks (*) to show that a rule is in place, as shown: 

 

. 
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Figure 40: Requesting a difference across scenarios 

 

 

Figure 41: The resulting scenario difference table 

 

4.4 Managing and sharing tables 
From the Table menu of the main VEDA-BE window, one may access the following table 

management functions: 

 

 Create a New Table; 
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 Save a table definition without launching the table view;  

 Open a table View;  

 Delete, Rename, and Copy tables. Note that Delete Table deletes only the currently 

selected table. To delete multiple tables at once, enter Batch Mode (described in Section 

6.2) from the View menu, by selecting Execution Mode and then Batch Mode. This will 

provide checkboxes next to each table, which can be used to multi-select tables. 

Choosing Delete Table from the Table menu will then allow all the selected tables to be 

deleted. 

 Import and Export tables using Excel or text format or the Access SnT file, in a manner 

precisely analogous to the import and export of sets described in Section 3.4; 

 Sort Tables alphabetically in ascending or descending order, or by modification date;  

 Delete saved Cube File(s), which forces recreation of tables from their definitions, if 

they have been saved as described in Section 2.3.7. This option may be requested if you 

suspect a cube is not refreshing appropriately; and 

 Open the Table Master window, described below. 

 

The Table Master provides a functionality for organizing tables into folders (Figure 42). 

Upon opening the Table Master window, you will be shown a folder structure with the 

uppermost level called All Tables, which always holds, as the name implies, all tables. You may 

add and delete folders and subfolders at will, creating a tree structure. The folders may be used in 

the main window to restrict the list of tables shown in the table definition window, by using the 

Open Folder(s) option from the View menu7. They may also be used to process (open for 

viewing) multiple or all tables within a folder from the Table Master window. 

 

 

Figure 42: The Table Master window 

                                                 
7 Note that the table list in the table definition form turns yellow when the open folder is set to 

anything other than All Tables to remind you that a filter has been set. 
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The toolbar at the top of the Table Master window offers the following tools: 

 

 New folder 

 Rename folder 

 Delete folder 

 Add tables to folder (opens a search window to find and select desired tables) 

 Remove selected tables from folder 

 Remove all tables from folder 

 Process (open for view) all tables in the selected folder 

 Process (open for view) selected tables in the selected folder 

 Refresh tables (if you have made changes to tables while the form was open) 

 Search for folder to open (useful if you have many folders) 

 Display options for tables (Large Icons, Small Icons, List, and Details) 

 Exit Table Master Window 

 

For example, to group all the price-related tables into a folder, use the following steps: 

 

 Click the New folder icon 

 Click the Rename folder icon, and enter “Prices” 

 Click the Plus-sign icon, which brings up a search window. Enter “pri” into the Include 

Where Code Like box, then click Select All, followed by OK.  

 

One may now open all of the Prices tables by choosing the appropriate icon from the toolbar. 
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5 VEDA-BE units handling 
VEDA-BE offers a simple yet powerful means for handling units. The user must identify the 

units to be used, provide each alternate unit conversion factor, and specify the native model units 

for each table. Once this is done, the resulting tables may be presented in any desired alternate 

units instead of the native model units. For example, we saw in Section 2.3.6 (Figure 19) that 

ELC Plants Production table is displayed in billion kilowatt-hours (Billion KWh), although the 

native energy carrier units for the DemoS_012 model are petajoules (PJ). 

To create, edit, and delete units and to specify unit conversion factors between them, select 

Units and then Create/Edit/Delete from the Tools menu to bring up the Units window (Figure 

43). The window offers the following tools: 

 To specify a new unit, click on the New Unit icon .  This clears the Unit Name and 

Unit Description textboxes on the right panel. Enter a name and, if desired, a description 

for the new unit, and click Update Unit Info. 

 To edit a unit’s name and/or description, select the unit from the list in the left panel. 

Make the desired changes to the name and/or description, and click Update Unit Info.  

 

 

Figure 43: The Units window in the DemoS_VBE database 

 

 To delete a unit, select it from the list in the left panel, and click on the Delete Unit icon 

. Click the Yes button when a message appears asking you to confirm the deletion of 

the unit. 

 To add a new unit conversion factor between two units, both must first be defined as 

described above. Then, select one of the two units from the list in the left panel. Click on 

Add Factor. This provides a textbox into which one may type what the currently active 

unit should be multiplied by to get the resulting unit. Enter the desired conversion factor 
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and then choose the resulting unit from the drop-down menu immediately to the right. 

Finally, click Update Unit Info.  

 

Conversions are automatically defined for the reciprocal relationship for each conversion 

factor created. However, additional conversions implied by this relationship with additional units 

are not automatically created and must be manually defined. 

For example, to define a new unit for megawatts (MW) and specify that it is 1/1000 of a GW, 

use the following steps: 

 

 Click on the New Unit icon.  

 Enter “MW” in the Unit Name textbox and “Megawatt” in the Unit Description textbox. 

Click Update Unit Info. 

 Click Add Factor. Type “.001” into the text box that appears. 

 Select “GW” from the drop-down menu to the right. 

 Click Update Unit Info. The Units window should now appear as shown in Figure 44. 

 

 

Figure 44: The Units window after adding MW 

 

Note that selecting “GW” in the left panel should now reveal that the conversion  

 

* 1000 = MW  
 

has been added to it. 

Units may be moved between VEDA-BE databases by using the units import/export function. 

To export units, select Export Unit(s) from the Tools menu. This will produce a prompt to name 

and provide a location in which to save a text (.UII) file. After you have clicked Save, a search 
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form will come up allowing you to select the units to export in a very similar manner to the 

export of sets described in Section 3.4.  

Choosing Import Unit(s) from the Tools menu will prompt you to locate and open a .UII 

file, and then allow you to search for and select the units to import. 

The user should carefully observe the following notes on using the units handling facility: 

 

 VEDA-BE does not know anything about native model units as they have been defined in 

VEDA-FE or ANSWER. The user must specify the native units in which results come to 

VEDA-BE from model using the table definition form, for each table where unit 

conversion is desired. These original units will be saved as part of the table definition. 

The units that appear when the table is viewed (the Active Units) may then be changed 

(and saved) within the view window.  

 It is not necessary to provide native units as part of the table definition if no unit 

conversion is desired. Thus this step in the table definition may be postponed until such 

time that conversion is desired. 

 Care needs to be taken when different attributes are mixed in a single table as they may 

be in different units. No native units should be provided for such a table, and the unit 

conversion facility should not be used, as the resulting values will be meaningless for the 

incompatible attribute(s). 
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6 Working with Excel and preparing reports 
This section addresses two key capabilities for conducting a TIMES analysis: moving results 

data out of VEDA-BE into Microsoft Excel for further processing, and preparing analysis 

reports.  

Results analysis often involves two distinct modes. One is exploratory in nature, where the 

analyst examines key results in the ExRES view and/or with a limited number of tables, drills 

into model details with the ExRES, exports selected pieces of data to Excel for further 

calculations, and designs new result tables to uncover new features of the results. There is a 

second mode, which may be called “production mode.” Here the table definitions and layouts 

have been stabilized, and it is desired to produce a set of tables and graphs without further user 

interference. After discussing two options for moving data into Excel, this section describes tools 

that may be used in production mode to produce analysis reports. 

 

6.1 Moving results data into Excel 
Two methods are available for moving data from the current table view into Excel. 

First method – Copy/Paste: In any open table view, right click in the numerical area of the 

table, and choose Copy Data from the menu that appears. (Optionally, select any portion of the 

data by dragging through the desired cells first.) Switch to Excel and use Edit->Paste or Ctrl-V 

to paste the data in the desired location. The VEDA-BE table and appropriate row/column 

headers will be pasted along with the data. If no data was selected before choosing Copy Data, 

the entire table will be copied. This method allows you to rapidly select desired data and place it 

exactly where you want it. 

Second method – Export: To move data from multiple tables to Excel automatically, use the 

Export method. First set user options for the handling of exported tables by choosing Options 

from the Tools menu of the main VEDA-BE window and going to the Export Options tab. Here 

you may set the path, file naming convention (add date/time stamp), and handling of multiple 

tables. Note that Excel is the recommended file type, and that Show Exported Data may not 

result in the exported files automatically opening after export, due to differences in how Excel 

may be configured on different machines. (On this tab you may also set behavior for Batch 

mode operations, as discussed in Section 6.2.) 

To export data, in any open table view, click the Export to Excel icon in the toolbar, or right 

click in the numerical area of the table, and choose Export from the menu that appears. All open 

tables will be placed in one or multiple Excel files in the designated destination folder, according 

to the Export Location option selected.  

 

6.2 The batch mode  
The batch mode provides an option for processing multiple tables automatically without user 

intervention. This choice is available under the View menu, Execution Mode command. All we 

have seen up until now about VEDA-BE has been in the Interactive mode of operation.  

If you choose the batch mode, the table definition window of the main screen is replaced by a 

list of existing tables, each preceded by a check box The user may then check any number of 

boxes, and VEDA-BE will process them as a batch when you click View Table(s). Figure 45 

shows an example of using the batch mode with four tables selected.  



 53 

 

 

Figure 45: The batch mode 

 

The operation(s) VEDA-BE performs on the requested tables depends on the Batch Mode 

Options set on the Export Options tab of the user options form, available by choosing Options 

from the Tools menu of the main VEDA-BE window. The user may request either or both of 

these options:  

 

 View Cube: will open each requested table into view mode.  

 Export: will export the requested tables according to the export options set as described in 

Section 6.1. 

 

With the batch mode and its options, the user can easily reconstruct standard sets of tables as 

runs are refined and new runs performed.  

The batch mode may also be used for database cleanup operations, to delete multiple tables at 

once. Choosing Delete Table from the Table menu while in batch mode will produce a prompt 

to confirm deletion of all tables with their checkboxes selected. 

An alternative way to open multiple tables simultaneously for viewing is from the Table 

Master window (see Section 4.4). Here the user can request that all or selected tables from a 

Table Master folder be processed. The open tables can then be exported as described in Section 

6.1. 

 

6.3 Updating VEDA-BE results in Excel workbooks 
Any Excel .xls format workbook containing tables that have been copy/pasted and/or exported 

using the methods described in Section 6.1 can be updated using the Update Excel file option 

from the Tools menu. When this tool is invoked, VEDA-BE will search the workbook for 

VEDA-BE tables corresponding to those in the open database, and then examine each data 

row/column, updating the data entries to the values currently in the associated tables. VEDA-BE 
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will highlight (in yellow) all processed values, and indicate any problems encountered (in red). A 

comment will be placed in the table name cell, indicating any global filters used in the 

processing. A log file is also created (by default in the \VEDA_BE\Logs folder) that can be 

viewed at the end of the update request. It will list tables successfully updated along with table 

names found in the workbook that could not be matched (usually because of some difference in 

configuration) to those in the database. 

This tool allows any calculations, graphs, etc. that are based upon results in a VEDA-BE 

table to be automatically updated with new results. The only restriction is that blank rows and 

columns should always be left on all four sides of tables that are to be updated by VEDA-BE, 

and blank rows/columns must not be inserted within the table. However, you can insert 

calculations such as growth rates/subtotals/shares within tables so long such row/column labels 

start with an asterisk (*).  

Figure 46 shows a simple version of such a workbook, where a line graph has been made 

which will be updated each time the results are updated.  

 

 

Figure 46: An Excel workbook updated with VEDA-BE results 

 

This is a powerful tool, but one that must be used with care and attention. VEDA-BE will 

update those data entries for which it finds a match in the table/row/column specifications. 

Therefore, the user must ensure that tables currently available in VEDA-BE match exactly in 

format those in the target workbook. That is, table definitions and formats must not have 

changed, and VEDA-BE must be able to find the intended data upon processing the table, taking 

into account any global filters that may be currently set. VEDA-BE helps the user take care not 

to change the definition of tables that have been used in updates by highlighting the table name 
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in red in the table definition form. It will also prompt you to reconsider if you attempt to save a 

change to the table definition. 

In addition, the user should bear in mind that only the rows/columns listed in the target 

workbook table will be updated. VEDA-BE will not add additional rows/columns that may 

appear in currently available tables that were not pasted/exported into the target workbook. This 

can pose a problem if items (e.g., processes, fuels) that were not active in the scenarios used to 

create the Excel tables become active in later scenarios. If VEDA-BE does encounter extra 

records in a database table that are not listed in an Excel table updated, an ExtraRecords text file 

will be produced in the log folder listing these values (see Figure 47). 

 

 

Figure 47: Sample ExtraRecords log file 

  

In order to ensure intended results, the following best practices are suggested: 

 

 Use sets rather than individual commodities/processes in tables wherever possible, as 

they are less likely to be omitted from some scenarios but appear in others. 

 Prepare tables for copying/exporting to Excel by summing over the widest possible range 

of scenarios. (Run the full range of anticipated scenarios, place the scenario dimension on 

the page of all tables, and do not include scenarios in the table definition.) This will help 

ensure that surprise items do not show up later in the analysis.  

 If elements are clearly missing, manually expand the target table to include them. 

 Check the log file (and the ExtraRecords file, if any) in the VEDA_BE\Logs folder after 

updates for any possible issues. 

 

Figure 48 shows how the Fuel consumption table was modified to prepare it for use in a 

workbook update. Process, commodity, scenario, and region have all been moved to the page. The 

desired scenario for any update will be selected using a global filter or through using the batch 

mode (described below). Individual regions may also be selected using a global filter or batch 

mode, or the table may be used to report the sum of results across regions. Finally, the table was 

saved with a different name (“for update”) so that the original table may continue to be used within 

VEDA-BE. 
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Figure 48: The Fuel consumption table as modified for use in update 

 

The Update Excel File command offers three options: 

 

 All Tables will prompt you to locate the desired workbook and update all properly 

formatted tables found in the workbook. 

 Selected Tables will provide a checklist of all properly formatted tables found in the 

selected workbook and prompt you to choose the desired ones. 

 Batch Mode will prompt you to select desired scenarios and regions, and then iterate the 

update process, producing separate workbooks for each scenario/region combination 

requested. If no regions are selected, the process will sum over all regions, subject to any 

global filter on regions in place at the time of update. (There is no option to sum over 

scenarios.) 

 

This function can be combined with Excel functions and macros to generate quite complex 

reports and graphics.  
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7 Best practices for using VEDA-BE 
This section provides a recap of advanced features and best practices discussed elsewhere in this 

manual that both new and experienced users are recommended to include in their repertoire. 

 

 Use the ExRES for model debugging and quick result viewing without building new 

tables. Set a default coloring scheme for the ExRES view, to help readily distinguish it 

from table views (Section 2.4). The ExRES view can also be an excellent way to 

introduce new users to model results, as it presents a deep dive into the currently active 

portion of the model RES. 

 When building and viewing tables, make use of global filters. Table definitions are 

meant to change only when you want to change the underlying logic of the table, not 

when you are just focused on a particular part of the results. Keep items that can better be 

applied to tables using global filters out of table definitions. Most commonly, this advice 

applies to scenarios and regions. Also, make use of the option to save and reuse global 

filter definitions (Section 2.3.5). 

 When defining sets, consider set maintenance. How well will your definitions hold up 

over time? Use model topology, or rigorously adhered to naming conventions, as the 

basis for set definitions. And consider how you can use intersections between processes, 

commodities and process and commodity sets to build tables. You may need fewer sets 

than you think. For example, to view final energy by end use and fuel in a sector, 

combine process sets for devices satisfying each end use with the attribute Var_FIn and 

commodity sets for types of fuels (e.g., all coal, all petroleum products, etc). Separate 

sets by sector/end use and fuel are not needed. 

 Use the units facility (Section 5) to readily convert tables from native model units to 

desired units for reporting. 

 Select the user option to save cube files (Section 2.3.7). This speeds up the presentation 

of repeatedly selected analysis tables (when no information has changed in the table since 

the last request). 

 Explore using Batch mode and Excel export and update operations to facilitate results 

reporting (Section 6). 

 Join the Veda Support Forum (link available from the Help menu). 
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Appendix A  
VEDA-BE TIMES Attributes 
 

Table A-1 provides a list of VEDA-BE TIMES attributes produced by the gdx2veda GAMS 

utility from a TIMES run GDX file, according to the times2veda.vdd directives (see Appendix 

B) and the reporting options (see Part III, Section 3.10) invoked with the run. Not all attributes 

listed will appear in every VEDA-BE database. Many attributes will not appear if the driving 

input attributes were not used in the model input. See Part II, Section 3.3.1 for more details on 

the TIMES reporting parameters. 
 

Table A-1 VEDA-BE attributes 

VEDA-BE attribute Dimensions 

involved* 

Description 

Cap_New p New capacity and lumpsum investment costs. (UC tags 

INSTCAP and LUMPINV, respectively.)  

Cost_Act p Annual variable activity costs of processes. Undiscounted. 

Cost_Com c Annual commodity costs. Undiscounted. 

Cost_Comx c Annual commodity taxes/subsidies. Undiscounted. 

Cost_Dam c Annual undiscounted commodity related damage costs, 

generated by DAM_COST. 

Cost_Dec p Annualized decommissioning costs for a process. 

Undiscounted. 

Cost_Els c Annual elastic demand costs (losses) due to elastic 

demand changes. Undiscounted. 

Cost_Fixx p Annual fixed taxes/subsidies associated with process 

installed capacity. Undiscounted. 

Cost_Flo p,c Annual flow costs (including exogenous import/export 

prices). Undiscounted. 

Cost_Flox p,c Annual undiscounted flow-related tax/subsidy costs 

(caused by FLO_TAX, FLO_SUB) in period (t) associated 

with a commodity (c) flow in/out of a process (p) with 

vintage period (v) as well as capacity related commodity 

flows. 

Cost_Fom p Annual fixed operating and maintenance costs. 

Undiscounted. 

Cost_Inv p Annualized investment costs. Undiscounted. 

Cost_Invx p Annual undiscounted investment taxes/subsidies,  

spread over the economic process lifetime. 

Cost_ire p Annual implied costs of endogenous trade, valued 

according to the marginal(s) of the trade equation of 

process p. Undiscounted 

Cost_NPV p,c Total discounted costs by component. See Table A-2 

below for components, and Part III, Section 3.10 for 

reporting options. 

COST_Salv p Salvage value of investment cost, taxes and subsidies of 

process (p) with vintage period (v), for which the technical 

lifetime exceeds the end of the model horizon, value at 

year EOH+1.  
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Dual_Clic c Climate module results for the duals of constraint related 

to climate variable (c) in period (t). 

EQ_Combal c Commodity Slack/Levels: commodity production minus 

consumption. 

EQ_CombalM c Commodity shadow price 

EQ_Cumflo p,c Level of cumulative constraint for flow of commodity (c) 

of process (p) between the year range (v–t). 

EQ_CumfloM p,c Shadow price of cumulative constraint for flow of 

commodity (c) of process (p) between the year range (v–

t). Not undiscounted. 

EQ_IreM p,c Inter-regional trade equation marginal. The undiscounted 

shadow price can be interpreted as the import/export price 

of the traded commodity. 

EQ_Peak c Peaking constraint slack 

EQ_PeakM c Peaking Constraint shadow price (price premium for 

consumption during peak timeslice paid by the consumer 

in addition to COMBAL price). 

ObjZ none Total discounted present value of system cost  

PAR_CapLO p Capacity lower limit 

PAR_CapUP p Capacity upper limit 

Reg_ACost r Regional total annualized costs by period and cost 

category. (See Table A-2 below for categories.) 

Reg_irec r Regional total discounted implied trade cost, derived by 

multiplying the shadow prices of the trade equations by 

the trade volumes. The sum of REG_IREC over regions is 

zero. 

Reg_obj r Regional total discounted system cost 

Reg_wobj r Regional total discounted system cost by cost type (uc_n). 

(See Table A-2 below for cost types.) 

Time_NPV  Present value of the time in each model period (t) by 

region (r), with s='ANNUAL' and 

uc_n='COST'/'LEVCOST' depending on whether the 

$SET ANNCOST LEV reporting option has been used. 

User_Con  Level of user constraint (or its slack). Only reported when 

the VAR_UC variables are used. 

User_ConFXM  User constraint shadow price. Undiscounted only if the 

constraint is defined by region and period. 

User_DynbM  Undiscounted shadow price of dynamic process-wise 

bound constraint, identified with name uc_n, for variable c 

(CAP / NCAP / ACT), in period t and timeslice s. 

Val_Flo p,c Annual commodity flow values: 

Flows of process (p) multiplied by the commodity balance 

marginals of those commodities (c), which can be 

interpreted as the market values of the process inputs and 

outputs. 

VAR_Act p Process activity level 

VAR_ActM p Process activity marginal. Annual undiscounted reduced 

cost of process activity variable. 

VAR_Cap p Process capacity. The vintage tags 0, -, and ¤ are used to 

indicate residual capacity, new capacity, and retired 
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capacity, respectively.  

VAR_CapM p Process capacity marginal. Undiscounted reduced cost of 

process capacity variable, when generated. 

VAR_Climate  Climate module results for the levels of climate variable 

(c) in period (t). 

VAR_Comnet c Commodity net quantity (consumption minus production); 

only generated when bound is specified by the user 

(COM_BNDNET). 

VAR_ComnetM c Dual variable of bound put on the net production of a 

commodity. 

VAR_Comprd c Commodity total production; only generated when bound 

is specified by the user (COM_BNDPRD). 

VAR_ComprdM c Dual variable of constraint related to the bound on the 

production of a commodity. 

VAR_CumCst  Cumulative costs by type (if constrained). 

VAR_Eout  Electricity output of electricity supply processes by energy 

source. (Opted out by default – set RPT_OPT('FLO','5')=1 

to activate; see Part III, Section 3.10). 

VAR_Fin p,c Commodity consumption by process 

VAR_Fout p,c Commodity production by process 

VAR_Ncap p Technology investment  

VAR_NcapM p Technology investment marginal. Undiscounted reduced 

cost of process investment variable. 

VAR_NcapR p Technology Investment – BenCost + ObjRange (see Part 

II, Section 3.3.3 and Part III, Section 3.10 for more 

details): 

Cost-benefit and ranging indicators for process (p) in 

period (t), where uc_n is the name of the indicator: 

• COST - the total unit costs of VAR_NCAP (in terms of 

an equivalent investment cost) 

• CGAP - competitiveness gap (in terms of investment 

costs), obtained directly from the VAR_NCAP 

marginals (and optional ranging information) 

• GGAP - competitiveness gap (in terms of investment 

costs), obtained by checking also the VAR_ACT, 

VAR_FLO and VAR_CAP marginals, in case 

VAR_NCAP is basic at zero 

• RATIO - benefit / cost ratio, based on CGAP 

• GRATIO - benefit / cost ratio, based on GGAP 

• RNGLO - ranging information (LO) for VAR_NCAP 

(if ranging is activated; in terms of investment costs) 

• RNGUP - ranging information (UP) for VAR_NCAP 

(if ranging is activated; in terms of investment costs) 

* p = process, c= commodity, r = region, t = period, s = timeslice, and v = vintage 

In addition, the r,t,s,v dimensions are involved for attributes involving processes, and the r,t,s dimensions 

for attributes involving commodities only. 
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Table A-2: Acronyms used in the cost reporting parameters. 

Cost parameter Component acronyms 

COST_NPV Total discounted costs by commodity/process: 

COM Commodity-related costs, taxes and subsidies 

ELS Losses in elastic demands 

DAM Damage costs 

INV Investment costs, taxes and subsidies, excluding portions 

attributable to hurdle rates in excess of the general discount rate 

INV+ Investment costs, taxes and subsidies, portions attributable to hurdle 

rates in excess of the general discount rate 

FIX Fixed costs, taxes and subsidies 

ACT Activity costs 

FLO Flows costs taxes and subsidies (including exogenous IRE prices) 

IRE Implied trade costs minus revenues 

REG_ACOST 

 

Regional total annualized costs by period: 

INV Annualized investment costs 

INVX Annualized investment taxes and subsidies 

FIX Annual fixed costs 

FIXX Annual fixed taxes and subsidies 

VAR Annual variable costs 

VARX Annual variable taxes and subsidies 

IRE Annual implied trade costs minus revenues 

ELS Annual losses in elastic demands 

DAM Annual damage costs 

REG_WOBJ 

 

Regional total discounted system cost by component: 

INV Investment costs 

INVX Investment taxes and subsidies 

FIX Fixed costs 

FIXX Fixed taxes and subsidies 

VAR Variable costs 

VARX Variable taxes and subsidies 

ELS Losses in elastic demands 

DAM Damage costs 
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Appendix B  
GDX2VEDA and the VEDA data definition file 
To get results from the GAMS solution (found in the GDX file) to VEDA-BE, the GDX2VEDA 

utility processes the GAMS GDX file according to the directives contained in the 

TIMES2VEDA.VDD (VEDA data definition) file, and produces the results files to be imported 

into VEDA-BE. The VDD file specifies which sets and model results are to be included and how 

to prepare this information for VEDA-BE. Thus the GDX2VEDA GAMS utility allows anyone 

familiar with a particular model to specify what information should be extracted from the GAMS 

model and passed to VEDA-BE. The call to the GDX2VEDA routine is embedded in the 

VTRUN / ANSRUN.CMD command routines. 

For those working with TIMES, an appropriate initial VDD file is distributed in the source 

code folder (one for conventional TIMES (and MACRO/MCA), and another for Stochastics), 

which requests the dumping of the information summarized in Appendix A. However, with a 

proper understanding of the VDD file, after saving the standard VDD, a knowledgeable user may 

carefully augment the VDD to request additional information be moved from GAMS to VEDA-

BE. 

In this Appendix we first simply reproduce the Command Prompt GDX2VEDA --help echoed 

help file, annotated with explanatory footnotes. The help file explains the way to call 

GDX2VEDA, as well as the various options available to the user in the VEDA Data Definition 

(VDD) file that control how and what gets dumped. The next section provides the initial 

TIMES2VEDA.VDD file for the core TIMES model distributed with the TIMES source code. 

The final section provides examples of the VD* results files.  

 

B.1 The GDX2VEDA help file 
 

>gdx2veda gdx vdd [run] 
 
   gdx  GAMS GDX file 
   vdd  VEDA Data Definition file 
   run  VEDA Run identifier (optional) 
 
The VEDA data file name and run identifier are either taken from the gdx file 
name or specified with the run name. Use "token with blanks" if needed. 
 
>gdx2veda mygdx    //  will dump the gdx symbols 
>gdx2veda          //  prints this message 
>gdx2veda --help   //  prints more detailed help message8  
 
Add .csv to the run name to write in csv format. 
 

                                                 
8 This message! 

The user is encouraged to first examine (via the GAMSIDE, see Section 2.3.3 of Part 

III) what information is found in the TIMES GDX file, including its structure 

(indexes), to determine what and how to introduce additional information to be 

dumped to the VDD. Furthermore, the process of changing the VDD should be done 

in consultation with someone fully familiar with the GAMS GDX file for TIMES and 

the basics of the GDX2VEDA utility. 
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VDD File Summary 
---------------- 
[DataBaseName]9 
 myveda 
 
[Dimensions]10 cube dimensions 
 long_name tuple_element1 tuple_element2 ...  
 
[DataEntries]11 data for the cube 
 long_name gams_name tuple_element1 tuple_element2 ...  
 
[DimensionText]12 for generating .vde file (only for data in [DataEntries]) 
 gams_set tuple_element1 tuple_element2 ...  
 
[DimensionTextAll]13 for generating .vde file (also for data not in 
[DataEntries]) 
 gams_set tuple_element1 tuple_element2 ...  
 
[SubSets]14 for generating .vds file 
 sub_name gams_name tuple_element1 tuple_element2 ... 
 
[ParentDimension] defines parent-child structure 
 parent_tab  child_tab1 child_tab2 ... 
 
[ParentDimensionTextAll] .vde file definitions with parent-child structure 
2d_gams_set  parent_tab child_tab 
2d_gams_set  child_tab parent_tab 
 
[ParentSubSets] .vds file definitions with parent-child structure 
sub_name 2d_gams_set parent_tab child_tab 
sub_name 2d_gams_set child_tab parent_tab 
 
[Options] 
TupleSeparator "string"  use a different separator symbol between tuple 
elements 
ShowAllSeparators        don't squeeze unnecessary separators 
RelaxDimensionAll        relax strict dimensionality checks in 
DimensionText(All) sections. 
ValueDim n               if n=2 write PV/DV value pairs for VEDA 
SetsAllowed dim1 dim2 .. write SetsAllowed specification line to VEDA .vd 
file 
Scenario scenarioSet     specify the scenario set; a record with expl text 
goes to .vde 
Format veda/csv          specify the format of the data files 
Not-0 attribute ...      don't write records with zero values for these 
attributes 
 
[SpecialValues] 
EPS "string"             value to be used for EPS 

                                                 
9 Name of the application.  
10 The various tabs to appear on the VEDA-BE screen. 
11 The individual data structures (Attributes) to be managed by VEDA-BE. 
12 Optional list of individual elements of the tab_names with their descriptions. Otherwise, all 

instances found in the data are enumerated and their associated description passed to VEDA-BE. 

If one [DimensionText] is provided the auto-generated tab list is not used. 
13 Optional list of additional elements of the tab_names not found in the set/index in the model 

data but whose description is desired.  
14 For each tab for which set management is to be performed by VEDA-BE, the system sets and 

subsets need to be provided. 
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INF "string"             value to be used for +INF 
MINF "string"            value to be used for -INF 
NA "string"              value to be used for NA 
UNDEF "string"           value to be used for UNDEF 
 
 
<myveda> is usually the application name which will be displayed  

on the top of the VEDA splash screen. When a new VEDA database is 
created, a new folder with this name will appear: 

         ...veda\database\mayveda_date_time. 
         where date and time are the creation time stamp. 
<tab_name> corresponds to the tabs of your VEDA screen 
 
Lines starting with * and empty lines are ignored.  
Blanks, commas and tabs are delimiters, blanks before and after delimiters 
are ignored. Quotes around data items are optional.  
The input data is NOT case sensitive. 
 
 
Example of a VEDA Data Definition file 
 
* Transport model 
 
[DataBaseName] 
myveda 
 
[Dimensions] 
* tab-name  indices 
Plants      i 
Warehouses  j 
Links  ii jj 
 
[DataEntries] 
* veda_attribute gams_name tab1 tab2 ... for gams index 1, 2, ... 
"x(i,j) duals" x.m      i  Warehouses 
Shipments      x.l      i  j 
SupplyPrice    supply.m i 
DemandPrice    demand.m j 
TransportCost  c        i  j 
Distance       d        ii jj 
Supply         a        i 
Demand         b        j 
TotalCost      z.l 
SupplyNodes    i        i 
DeamndNodes    j        j 
Rate           f 
 
[DimensionText] 
* gams_set tab 
i  i 
 
[DimensionTextAll] 
j  j 
 
[SubSets] 
* sub_name gams_name tab 
i1 ic  Plants   
i1 id  i 
 
Notes: 
The long name from the [Dimensions] section can be used as a macro that  
expands to the tuples it defines. E.g. “Links” is identical to “ii jj”.   
In the [DataEntries] section a literal tuple element can be defined as 
/element/.  
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When ValueDim=2, the [DataEntries] section can contain X.LM entries, 
indicating both .L and .M needs to written as a pair.     

 

B.2  The TIMES2VEDA.VDD file for the core TIMES model 
* 
* TIMES GDX2VEDA Set Directives 
* 
 
[DataBaseName] 
 TIMES 
 
[Dimensions] 
 Attribute        attr 
 Commodity        c 
 Process          p 
 Period           t 
 Region           r 
 Vintage          v 
 TimeSlice        s 
 UserConstraint  uc_n 
 
[ParentDimension] 
 Region Commodity Process UserConstraint 
 
[Options] 
SetsAllowed Commodity Process UserConstraint 
*Scenario SCENCASE 
*ValueDim 2 
not-0 var_fin var_fout var_act var_actm var_cap var_capm cost_flo cost_act 
eq_cumflo eq_combal eq_combalm 
 
[DataEntries] 
* VEDA Attr     GAMS             - indexes - 
*** Variables & Parameters 
  VAR_Act       par_actl         r v t p s 
  VAR_ActM      par_actm         r v t p s 
  VAR_Cap       par_capl         r t p 
  VAR_Cap       par_pasti        r t p v 
  VAR_CapM      par_capm         r t p 
  VAR_Ncap      par_ncapl        r t p 
  VAR_NcapM     par_ncapm        r t p 
  VAR_NcapR     par_ncapr        r t p uc_n 
  VAR_FIn       f_in             r v t p c s 
  VAR_FOut      f_out            r v t p c s 
  VAR_FOut      agg_out          r t c s 
  VAR_Comprd    par_comprdl      r t c s 
  VAR_ComprdM   par_comprdm      r t c s 
  VAR_Comnet    par_comnetl      r t c s 
  VAR_ComnetM   par_comnetm      r t c s 
  VAR_Eout      par_eout         r v t p c 
  VAR_CumCst    par_cumcst       r v t uc_n c 
*** Equations 
  EQ_Combal     eqg_combal.l     r t c s 
  EQ_CombalM    par_combalem     r t c s 
  EQ_Combal     eqe_combal.l     r t c s 
  EQ_CombalM    par_combalgm     r t c s 
  EQ_Peak       eq_peak.l        r t c s 
  EQ_PeakM      par_peakm        r t c s 
  EQ_IreM       par_ipric        r t p c s uc_n 
  EQ_Cumflo     par_cumflol      r p c v t 
  EQ_CumfloM    par_cumflom      r p c v t 
*** Parameters 
  PAR_Top       par_top          r t p c uc_n 
  PAR_CapLO     par_caplo        r t p 
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  PAR_CapUP     par_capup        r t p 
  Cap_New       Cap_New          r v p t uc_n 
*** Costs 
  Cost_Inv      cst_invc         r v t p uc_n 
  Cost_Invx     cst_invx         r v t p uc_n 
  Cost_Salv     cst_salv         r v p 
  Cost_Dec      cst_decc         r v t p 
  Cost_Fom      cst_fixc         r v t p 
  Cost_Fixx     cst_fixx         r v t p 
  Cost_Act      cst_actc         r v t p uc_n 
  Cost_Flo      cst_floc         r v t p c 
  Cost_Flox     cst_flox         r v t p c 
  Cost_Com      cst_comc         r t c 
  Cost_Comx     cst_comx         r t c 
  Cost_Els      cst_come         r t c 
  Cost_Dam      cst_dam          r t c 
  Cost_ire      cst_irec         r v t p c 
  Cost_NPV      cst_pvp          uc_n r p 
  Cost_NPV      cst_pvc          uc_n r c 
  Time_NPV      cst_time         r t s uc_n 
  Val_Flo       val_flo          r v t p c 
  ObjZ          ObjZ.l 
  Reg_wobj      reg_wobj         r uc_n c 
  Reg_obj       reg_obj          r 
  Reg_irec      reg_irec         r 
  Reg_ACost     reg_acost        r t uc_n 
  User_con      par_ucsl         uc_n r t s 
  User_conFXM   par_ucsm         uc_n r t s 
  User_conFXM   par_ucmrk        r t uc_n c s 
  User_DynbM    par_ucrtp        uc_n r t p c 
  User_MaxBet   par_ucmax        uc_n r p c 
*** Climate and MACRO 
  VAR_Climate   CM_RESULT        c t 
  Dual_clic     CM_MAXC_M        c t 
  VAR_Macro     TM_RESULT        c r t 
 
[DimensionTextAll] 
* Gams_set_name  Veda_Tab 
adesc    attr 
uc_n     uc_n 
sysuc    uc_n 
 
[ParentDimensionTextAll] 
* Gams_set_name  Veda_Tab 
prc_desc   r p 
com_desc   r c 
 
[ParentSubSets] 
*  subset  GAMS    VEDA Tab 
* processes 
  DMD DMD     r p 
  PRE PRE     r p 
  PRW PRW     r p 
  PRV PRV     r p 
  REF REF     r p 
  ELE ELE     r p 
  CHP CHP     r p 
  HPL HPL     r p 
  STG RP_STG  r p 
  DISTR DISTR r p 
  IRE RP_IRE  r p 
* commodities 
  NRG  NRG    r c 
  DEM  DEM    r c 
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  ENV  ENV    r c 
  MAT  MAT    r c 
  RES  RES    r c 
  COMM COMM   r c 
  TRN  TRN    r c 
  AGR  AGR    r c 
  NE   NE     r c 
  IND  IND    r c 
  ELC+ NRGELC r c 
  HET+ NRGHET r c 
  UC_Const uc_r_each r uc_n 
  UC_Const uc_const  r uc_n 
  UC_DynBD uc_dynbd  r uc_n 

 

B.3 The VEDA-BE results files 
There are three files produced for VEDA-BE by the GDX2VEDA utility: the 

<scenarioname>.VD data dump with the attributes, <scenarioname>.VDE (set elements), and 

<scenarioname>.VDS (sets definition). In addition, VEDA-FE and ANSWER produce a 

<scenarioname>.VDT (topology) file with the RES connectivity information. These files are 

dumped in comma delimited format. They never require user intervention, though they may be 

processed by other software if desired.  

Snippets of each file are shown below, after a brief description of the layout of each. 

 

B.3.1 <scenarioname>.VD 

The <scenarioname>.VD file contains the application VEDA-BE header directives (controlling 

the appearance of the main VEDA-BE table specification form) followed by the actual model 

data. 

 

Layout, after the header: Attribute, Commodity, Process, Period, Region, Vintage, Timeslice, 

UserConstraint, Value; 

 

Excerpt: 
*  GDX2VEDAversion- 2005-10-07 

*         ImportID- Scenario:DemoS_012b 

*       VEDAFlavor- TIMES 

*       Dimensions- 

Attribute;Commodity;Process;Period;Region;Vintage;TimeSlice;UserConstraint

;PV 

* ParentDimensions- Commodity: Region; Process: Region 

*      SetsAllowed- Commodity;Process 

*        FieldSize- 

Attribute:31;Commodity:31;Process:31;Period:31;Region:31;Vintage:31;TimeSl

ice:31;UserConstraint:31;PV:20 

*       NotIndexed- PV 

*         ValueDim- PV 

*  DefaultValueDim- PV 

*   FieldSeparator- , 

*        TextDelim- " 

 

"VAR_Act","-","AOTETOT","2005","REG1","2005","ANNUAL","-",564.8409 

"VAR_Act","-","CAPEELC","2005","REG1","2005","ANNUAL","-",1148.6992095 

"VAR_Act","-","COTEBIO","2005","REG1","2005","ANNUAL","-",3.939 

"VAR_Act","-","COTECOA","2005","REG1","2005","ANNUAL","-",37.3712625 
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"VAR_Act","-","COTEELC","2005","REG1","2005","ANNUAL","-",63.8166227499999 

"VAR_Act","-","COTEGAS","2005","REG1","2005","ANNUAL","-",212.309676 

"VAR_Act","-","COTEOIL","2005","REG1","2005","ANNUAL","-",129.503715 

"VAR_Act","-","CSHEBIO","2005","REG1","2005","ANNUAL","-",35.451 

"VAR_Act","-","CSHEELC","2005","REG1","2005","ANNUAL","-",63.81662275 

"VAR_Act","-","CSHEGAS","2005","REG1","2005","ANNUAL","-",495.389244 

"VAR_Act","-","CSHEOIL","2005","REG1","2005","ANNUAL","-",302.175335 

"VAR_Act","-","CSHESOL","2005","REG1","2005","ANNUAL","-",7.575 

"VAR_Act","-","ELCNENUC00","2005","REG1","2005","S","-",746.220483540681 

"VAR_Act","-","ELCNENUC00","2005","REG1","2005","W","-",723.929516459321 

"VAR_Act","-","ELCREHYD00","2005","REG1","2005","SD","-",244.125 

"VAR_Act","-","ELCREHYD00","2005","REG1","2005","SN","-",0.837000000000359 

"VAR_Act","-","ELCREHYD00","2005","REG1","2005","WD","-",243.846 

"VAR_Act","-","ELCRESOL00","2005","REG1","2005","SD","-",16.9805936073059 

"VAR_Act","-","ELCRESOL00","2005","REG1","2005","SN","-",10.4147640791476 

"VAR_Act","-","ELCRESOL00","2005","REG1","2005","WD","-",16.9611872146119 

"VAR_Act","-","ELCRESOL00","2005","REG1","2005","WN","-",12.2907153729072 

"VAR_Act","-","ELCREWIN00","2005","REG1","2005","SD","-",71.5472816780823 

"VAR_Act","-","ELCREWIN00","2005","REG1","2005","SN","-",43.3049336472603 

"VAR_Act","-","ELCREWIN00","2005","REG1","2005","WD","-",75.2268561643836 

"VAR_Act","-","ELCREWIN00","2005","REG1","2005","WN","-",71.5472816780823 

"VAR_Act","-","ELCTECOA00","2005","REG1","2005","S","-",1351.31629846897 

"VAR_Act","-","ELCTECOA00","2005","REG1","2005","W","-",1044.37445353102 

"VAR_Act","-","ELCTEGAS00","2005","REG1","2005","SD","-",226.711979456911 

"VAR_Act","-","ELCTEGAS00","2005","REG1","2005","SN","-",300.30842173892 

"VAR_Act","-","EXPCOA1","2005","REG1","2005","ANNUAL","-",745.59485 

"VAR_Act","-","EXPHFO1","2005","REG1","2005","ANNUAL","-",804.770973903333 

"VAR_Act","-","EXPKER1","2005","REG1","2005","ANNUAL","-",295.3885 

"VAR_Act","-","EXPLPG1","2005","REG1","2005","ANNUAL","-",32.1237949472747 

"VAR_Act","-","EXPNAP1","2005","REG1","2005","ANNUAL","-",400.84 

"VAR_Act","-","EXPOIL1","2005","REG1","2005","ANNUAL","-",1648.4855 

"VAR_Act","-","EXPOPP1","2005","REG1","2005","ANNUAL","-",453.036 

"VAR_Act","-","FTE-AGRBIO","2005","REG1","2005","ANNUAL","-

",8.9265138547333 

"VAR_Act","-","FTE-AGRCOA","2005","REG1","2005","ANNUAL","-

",8.46903001967851 

"VAR_Act","-","FTE-AGRELC","2005","REG1","2005","SD","-",72.2276809309521 

"VAR_Act","-","FTE-AGRELC","2005","REG1","2005","SN","-",66.4494664564759 

"VAR_Act","-","FTE-AGRELC","2005","REG1","2005","WD","-",72.1451350098882 

"VAR_Act","-","FTE-AGRELC","2005","REG1","2005","WN","-",78.418625010748 

"VAR_Act","-","FTE-AGRGAS","2005","REG1","2005","ANNUAL","-

",160.377867843615 

"VAR_Act","-","FTE-AGROIL","2005","REG1","2005","ANNUAL","-

",97.8265808739081 

"VAR_Act","-","FTE-COMBIO","2005","REG1","2005","ANNUAL","-",48.25275 

"VAR_Act","-","FTE-COMCOA","2005","REG1","2005","ANNUAL","-",37.3712625 

"VAR_Act","-","FTE-COMELC","2005","REG1","2005","SD","-",309.846497299342 

"VAR_Act","-","FTE-COMELC","2005","REG1","2005","SN","-",309.846497299342 

"VAR_Act","-","FTE-COMELC","2005","REG1","2005","WD","-",329.999115009868 

"VAR_Act","-","FTE-COMELC","2005","REG1","2005","WN","-",329.999115009868 

"VAR_Act","-","FTE-COMGAS","2005","REG1","2005","ANNUAL","-

",762.742169333334 

"VAR_Act","-","FTE-COMOIL","2005","REG1","2005","ANNUAL","-",507.22288375 
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B.3.2 <scenarioname>.VDE 

The <scenarioname>.VDE file contains the list of individual set member elements for each index 

managed by VEDA-BE along with their descriptions. 

 

Layout: Dimension Name - Region - Element name - Element Description; 

 

Excerpt: 
"Attribute","-","VAR_act","Process Activity" 

"Attribute","-","VAR_actM","Process Activity - Marginals" 

"Attribute","-","VAR_cap","Technology Capacity" 

"Attribute","-","VAR_capM","Technology Capacity - Marginals" 

"Attribute","-","VAR_ncap","Technology Investment - New capacity" 

"Attribute","-","VAR_ncapM","Technology Investment - Marginals" 

"Attribute","-","VAR_ncapR","Technology Investment - BenCost + ObjRange" 

"Attribute","-","VAR_fin","Commodity Consumption by Process" 

"Attribute","-","VAR_fout","Commodity Production by Process" 

"Attribute","-","VAR_comprd","Commodity Total Production" 

"Attribute","-","VAR_comprdM","Commodity Total Production - Marginal" 

"Attribute","-","VAR_comnet","Commodity Net" 

"Attribute","-","VAR_comnetM","Commodity Net - Marginal" 

"Attribute","-","VAR_eout","Electricity supply by technology and energy 

source" 

"Attribute","-","EQ_combal","Commodity Slack/Levels" 

"Attribute","-","EQ_combalM","Commodity Slack/Levels - Marginals" 

"Attribute","-","EQ_peak","Peaking Constraint Slack" 

"Attribute","-","EQ_peakM","Peaking Constraint Slack - Marginals" 

"Attribute","-","EQ_Cumflo","Cumulative flow constraint - Levels" 

"Attribute","-","EQ_CumfloM","Cumulative flow constraint - Marginals" 

"Attribute","-","PAR_capLO","Capacity Lower Limit" 

"Attribute","-","PAR_capUP","Capacity Upper Limit" 

"Attribute","-","PAR_Top","Process topology (Opted out - SET RPT_TOP YES 

to activate)" 

"Attribute","-","Cap_New","Newly installed capacity and lumpsum investment 

by vintage and commissioning period" 

"Attribute","-","COST_inv","Annual investment costs" 

"Attribute","-","COST_dec","Annual decommissioning costs" 

"Attribute","-","COST_salv","Salvage values of capacities at EOH+1" 

"Attribute","-","COST_late","Annual late costs" 

"Attribute","-","COST_fom","Annual fixed operating and maintenance costs" 

"Attribute","-","COST_act","Annual activity costs" 

"Attribute","-","COST_flo","Annual flow costs (including import/export 

prices)" 

"Attribute","-","COST_com","Annual commodity costs" 

"Attribute","-","COST_els","Annual elastic demand cost term" 

"Attribute","-","COST_dam","Annual damage cost term" 

"Attribute","-","COST_invx","Annual investment taxes/subsidies" 

"Attribute","-","COST_fixx","Annual fixed taxes/subsidies" 

"Attribute","-","COST_flox","Annual flow taxes/subsidies" 

"Attribute","-","COST_comx","Annual commodity taxes/subsidies" 

"Attribute","-","COST_ire","Annual implied costs of endogenous trade" 

"Attribute","-","COST_NPV","Total discounted costs by process/commodity 

(optional)" 

"Attribute","-","Time_NPV","Discounted value of time by period" 
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"Attribute","-","VAL_Flo","Annual commodity flow values" 

"Attribute","-","ObjZ","Total discounted system cost" 

"Attribute","-","Reg_wobj","Regional total expected discounted system 

cost" 

"Attribute","-","Reg_obj","Regional total discounted system cost" 

"Attribute","-","Reg_irec","Regional total discounted implied trade cost" 

"Attribute","-","Reg_ACost","Regional total annualized costs by period" 

"Attribute","-","User_Con","Level of user constraint" 

"Attribute","-","User_ConFXM","Marginal cost of fixed bound user 

constraint" 

"Attribute","-","User_ConLOM","Marginal cost of lower bound user 

constraint" 

"Attribute","-","User_ConUPM","Marginal cost of upper bound user 

constraint" 

"Attribute","-","User_DynbM","Marginal cost of dynamic process bound 

constraint" 

"Attribute","-","User_Maxbet","Level of MaxBet constraint" 

"Attribute","-","VAR_climate","Climate result variables" 

"Attribute","-","Dual_Clic","Shadow price of climate constraint" 

"Attribute","-","VAR_Macro","MACRO result variables" 

"Commodity","REG2","GAS","Natural Gas" 

"Commodity","REG1","GAS","Natural Gas" 

"Commodity","REG2","ELC","Electricity" 

"Commodity","REG1","ELC","Electricity" 

"Commodity","REG2","AGRBIO","Agriculture Biomass" 

"Commodity","REG1","AGRBIO","Agriculture Biomass" 

"Commodity","REG2","AGRCO2","Agriculture Carbon dioxide" 

"Commodity","REG1","AGRCO2","Agriculture Carbon dioxide" 

"Commodity","REG2","AGRCOA","Agriculture Solid Fuels" 

"Commodity","REG1","AGRCOA","Agriculture Solid Fuels" 

"Commodity","REG2","AGRELC","Agriculture Electricity" 

"Commodity","REG1","AGRELC","Agriculture Electricity" 

"Commodity","REG2","AGRGAS","Agriculture Natural Gas" 

"Commodity","REG1","AGRGAS","Agriculture Natural Gas" 

"Commodity","REG2","AGROIL","Agriculture oil" 

"Commodity","REG1","AGROIL","Agriculture Oil" 

"Commodity","REG2","BIO","Biomass" 

"Commodity","REG1","BIO","Biomass" 

"Commodity","REG2","COA","Solid Fuels" 

"Commodity","REG1","COA","Solid Fuels" 

"Commodity","REG2","COMBIO","Commercial Biomass" 

"Commodity","REG1","COMBIO","Commercial Biomass" 

"Commodity","REG2","COMCO2","Commercial Carbon dioxide" 

"Commodity","REG1","COMCO2","Commercial Carbon dioxide" 

"Commodity","REG2","COMCOA","Commercial Solid Fuels" 

"Commodity","REG1","COMCOA","Commercial Solid Fuels" 

"Commodity","REG2","COMELC","Commercial Electricity" 

"Commodity","REG1","COMELC","Commercial Electricity" 

"Commodity","REG2","COMGAS","Commercial Natural Gas" 

"Commodity","REG1","COMGAS","Commercial Natural Gas" 

"Commodity","REG2","COMOIL","Commercial oil" 

"Commodity","REG1","COMOIL","Commercial Oil" 

"Commodity","REG2","COMSOL","Commercial Solar energy" 

"Commodity","REG1","COMSOL","Commercial Solar energy" 



 71 

 

B.3.3 <scenarioname>.VDS 

The <scenarioname>.VDS file provides the set membership information for the dimensions 

where sets are allowed. Note that these are different from the user-defined sets (rule-based) that 

are managed in VEDA BE. But these sets can be used as a part of those rules. 

 

Layout: Type of set (tab), region, set name, item name; 

 

Excerpt: 
"Commodity","REG1","ELC+","ELC" 

"Commodity","REG2","ELC+","ELC" 

"Commodity","REG1","ELC+","AGRELC" 

"Commodity","REG2","ELC+","AGRELC" 

"Commodity","REG1","ELC+","COMELC" 

"Commodity","REG2","ELC+","COMELC" 

"Commodity","REG1","ELC+","RSDELC" 

"Commodity","REG2","ELC+","RSDELC" 

"Commodity","REG1","ELC+","TRAELC" 

"Commodity","REG2","ELC+","TRAELC" 

"Commodity","REG1","ENV","AGRCO2" 

"Commodity","REG2","ENV","AGRCO2" 

"Commodity","REG1","ENV","COMCO2" 

"Commodity","REG2","ENV","COMCO2" 

"Commodity","REG1","ENV","ELCCO2" 

"Commodity","REG2","ENV","ELCCO2" 

"Commodity","REG1","ENV","INDCO2" 

"Commodity","REG2","ENV","INDCO2" 

"Commodity","REG1","ENV","RSDCO2" 

"Commodity","REG2","ENV","RSDCO2" 

"Commodity","REG1","ENV","TOTCO2" 

"Commodity","REG2","ENV","TOTCO2" 

"Commodity","REG1","ENV","TRACO2" 

"Commodity","REG2","ENV","TRACO2" 

"Commodity","REG1","DEM","DAOT" 

"Commodity","REG2","DEM","DAOT" 

"Commodity","REG1","DEM","DCAP" 

"Commodity","REG2","DEM","DCAP" 

"Commodity","REG1","DEM","DCOT" 

"Commodity","REG2","DEM","DCOT" 

"Commodity","REG1","DEM","DCSH" 

"Commodity","REG2","DEM","DCSH" 

"Commodity","REG1","DEM","DIDM1" 

"Commodity","REG2","DEM","DIDM1" 

"Commodity","REG1","DEM","DRAP" 

"Commodity","REG2","DEM","DRAP" 

"Commodity","REG1","DEM","DROT" 

"Commodity","REG2","DEM","DROT" 

"Commodity","REG1","DEM","DRSH" 

"Commodity","REG2","DEM","DRSH" 

"Commodity","REG1","DEM","DTCAR" 

"Commodity","REG2","DEM","DTCAR" 

"Commodity","REG1","DEM","DTPUB" 

"Commodity","REG2","DEM","DTPUB" 

"Commodity","REG1","NRG","GAS" 
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B.3.4 <scenarioname>.VDT 

The <scenarioname>.VDT file contains all the Reference Energy System (RES) topology 

information. 

 

Layout: Region, Process, Commodity, IN/OUT topology indicator. VEDA BE also enables one 

to look at UCs that are related to a process or commodity. <UC Name>, Process, Commodity, 

“UC” entries are needed for that. 

 

Excerpt: 
*VFEPATH=C:\Veda\VEDA_Models\DemoS_012 

*ScenDesc=Demo Step 012 CO2 Tax 

*ScenEDesc=Demo Step 012 CO2 Tax 

"AU_NUC_MaxCAP","ELCNENUC00","-","UC" 

"AU_NUC_MaxCAP","ELCNNNUC01","-","UC" 

"REG1","AOTETOT","AGRBIO","IN" 

"REG1","AOTETOT","AGRCO2","OUT" 

"REG1","AOTETOT","AGRCOA","IN" 

"REG1","AOTETOT","AGRELC","IN" 

"REG1","AOTETOT","AGRGAS","IN" 

"REG1","AOTETOT","AGROIL","IN" 

"REG1","AOTETOT","DAOT","OUT" 

"REG1","AOTETOT","DEMO","OUT" 

"REG1","AOTETOT","NRGI","IN" 

"REG1","CAPEELC","COMELC","IN" 

"REG1","CAPEELC","DCAP","OUT" 

"REG1","CAPEELC","DEMO","OUT" 

"REG1","CAPEELC","NRGI","IN" 

"REG1","CAPNELC1","COMELC","IN" 

"REG1","CAPNELC1","DCAP","OUT" 

"REG1","CAPNELC1","DEMO","OUT" 

"REG1","CAPNELC1","NRGI","IN" 

"REG1","COTEBIO","COMBIO","IN" 

"REG1","COTEBIO","DCOT","OUT" 

"REG1","COTEBIO","DEMO","OUT" 

"REG1","COTEBIO","NRGI","IN" 

"REG1","COTECOA","COMCO2","OUT" 

"REG1","COTECOA","COMCOA","IN" 

"REG1","COTECOA","DCOT","OUT" 

"REG1","COTECOA","DEMO","OUT" 

"REG1","COTECOA","NRGI","IN" 

"REG1","COTEELC","COMELC","IN" 

"REG1","COTEELC","DCOT","OUT" 

"REG1","COTEELC","DEMO","OUT" 

"REG1","COTEELC","NRGI","IN" 

"REG1","COTEGAS","COMCO2","OUT" 

"REG1","COTEGAS","COMGAS","IN" 

"REG1","COTEGAS","DCOT","OUT" 

"REG1","COTEGAS","DEMO","OUT" 

"REG1","COTEGAS","NRGI","IN" 

"REG1","COTEOIL","COMCO2","OUT" 

"REG1","COTEOIL","COMOIL","IN" 

"REG1","COTEOIL","DCOT","OUT" 

"REG1","COTEOIL","DEMO","OUT" 


